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How To Use This Manual

This manual is divided into several parts that explain how to get the most out of
DeskMate. Some parts are designed to be used as learning aids and others as refer-
ence tools. First, familiarize yourself with “Getting Started,” and make a copy of your
DeskMate diskette. Next, turn to the Sample Session and practice using all of Desk-
Mate's applications, or just work through those portions you want. When you are
experienced in running DeskMate, you will use the Reference part almost exclusively.

About the Parts Of the Manual

Getting Started—Lists DeskMate’s applications, necessary and optional equipment,
and conventions used in the manual. Explains, in detail, the fundamentals of run-
ning DeskMate, including loading DeskMate, making copies of your diskette, and
using the keyboard or the mouse/joystick to move around on the screen. Provides
information about DeskMate’s Main Menu.

Sample Session—Provides examples designed to help you become comfortable with
running DeskMate.

Reference—Gives detailed instructions about each DeskMate application.

Appendices—Includes technical information for those who want to utilize the capabili-
ties of DeskMate more thoroughly, a list of error messages, a glossary of terms, and
technical information for the Telecom user. ) '

Index—Provides quick access to all parts of the manual.

Conventions Used in the Manual
Information that appears on the screen is printed in blue.
The information that vou are asked to ““type” is printed in boldface.

The Sample Session presents information in steps, noted by blue boxes. Accompanying
thie steps is extra information to help you with the instructions. For example:

Place the cursor near the center of the screen.

Keyboard: Move the cursor to the center of the screen and press the space bar.

5.



L

BAGRSRT RS pos o

% 5 ] Roe T

L2 ot

[Reieeiition] 71— s i Sy A Boitilasd Sellakedinide L=y

How to Use This Manual

Mouse/Joystick: Move the cursor to the center of the screen and click.

As vou become more familiar with DeskMate, you might want to skip the extra infor-
mation. When you first start the Sample Session, however, read all the information.

You'll often be asked to press combinations of keys, such as [ALT] ["). When you see
two keys together, hold down the first key, and gently press and release the second
one.

Icons (like those on the screen) are used in many places in the manual to clarify
instructions.

Some Tandy Color Computers may use [@] instead of [ALT), and [CLEAR] instead of

CTRL L
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Introduction

To add to DeskMate’s versatility, you can add:
+  Joystick or Mouse
* A second disk drive

¢ Any printer with a serial port (for example, a dot matrix, daisy wheel, or ink
jet printer)

Nete: The Paint application cannot use a Daisy Wheel printer for printing pictures
you create,

To use Telecom, you must have:
* A standard modem
* RS5-232 Pak

+ A Multipak Interface

Connecting Equipment

Connect your equipment according to the instructions in the manual(s) that came with
it. To use Telecom, set up your equipment as instructed in Chapter 17, “Telecom.”

Introduction
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Getting
Started

The first three chapters in this part of the manual contain infor-
mation on those procedures you must follow before working
through the Sample Session or using DeskMate on your owr.
Read and follow all instructions on these procedures:

¢ Loading DeskMate

e Choosing the device (keyboard, mouse, or joystick) that
you plan to use to move the cursor around the screen

e Copying your diskette

Chapter 2 also tells you how to move’ around the screen using
the device you choose and explains terms that you will encounter
throughout the manual.

Chapter 4 describes the options and utilities you can choose from
DeskMate’s Main Menu to perform various tasks. You do not
need to follow any of the instructions in Chapter 4 before begin-
ning the Sample Session. You can read through it now or refer to
it later when you want information about DeskMate's Main

Menu,

Getting Started
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Chapter 1

Loading DeskMate

To begin using DeskMate on your Color Computer:

Connect any “optional” equipment you're using, such as a mouse, joystick, or
printer, to the computer. If you don’t know how to connect the various pieces,
read the owner's manual you received with the equipment. (See Chapter 18,
“"Telecom,” for information on setting up necessary communications equipment.)

Turn on the system. The screen should show:

Disk £xtended Color BASIC v.r.
Copyright (£) 128x by Tandy
Under License from Microsoft
Ok

If you don't see a copyright notice, try pressing the reset button. If the Ok mes-
sage still doesn’t appear, turn off your computer, and check that all your equip-
ment is connected securely. Then, turn on the computer again.

Place the DeskMate diskette in Drive 0, and close the drive door. Type DOS
(ENTER ). If vou have Disk Extended Basic, see Appendix G. In a few seconds, you'll
see the O5-9 copyright message, followed by DeskMate's title screen, and then a
date and Hme prompt.

4. Type the current date and press (for example, 7/3/1986 [ENTER ).

Getting Started
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SIS

5. Type the current time and press (ENTER | {for example, 12:30. PM [ENTER ).

After you enter the time, the following screen appears.

Menu Bar

———Folder icons

Directory window

The name of each application is shown along with the icon (picture) that represents it.
There is a Menu Bar at the top of the screen that contains various DeskMate functions

and Folder icons on the right of the screen.

You'll learn more about the Main Menu of DeskMate later. Right now, there are some
important things you need to know about moving around on DeskMate’s screens and
making copies of your DeskMate diskette.

Note: If you want to turn off vour computer, be sure that DeskMate’s Main Menu
is on the screen. Then, remove the diskette(s), and turn off the computer.

6 Getting Started
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Chapter 2

Moving Around

When you first see the DeskMate Main Menu, the Calendar application is surrounded
by 2 box and can be selected. Throughout DeskMate, you can move the highlight, box,
“check” mark, or other method of emphasis around on the screen and make selections
with the kevboard or a mouse or joystick. The instructons below contain specific
information for the device you'll be using.

Choosing the Device

As you use DeskMate, you will maneuver the cursor or the method of emphasis by
using either the keyboard or a mouse or joystick. To choose the device you want to
use, follow the instructions below.

1. Press [Al1)[7] to select the Icon Bar.
, Cursor icon
Folder Calculator Control Bar

r{\ter \Time Display T Help

\Pri
:f’ 2

This is the-Icon Bar. The icons represent DeskMate’s subfunctions, such as the
printer and calculator.

2 B Use the arrow keys to move the highlight to the cursor option, and
press [ENTER |
Getting Started ' 7



Lidnsmies

R csd i

Choecse iype of cursor
conirel device:
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) Mouse or Joyslick
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3. Use the arrow keys to move the highlighted “check” to the option you want, an
press [ENTER |. You return to DeskMate’s Main Menu.

] Keybozrd only

d

You can now use the method you chose throughout DeskMate.

v

Using the Keyboard

Use the chart below as a quick reference when you want to know how to move around

on the screen using the keyboard. (Any exceptions are discussed under specific

Press:

(a3

AT ()
(e ()
(ad) =]

(@D 5

Liaaes — ——

g

applications.)

Io move the highlight or cursor:

Back one character, erasing the character beneath it
To select the Icon Bar

To select the Help Window

To the Menu Bar

To thé Main Menu from the Menu Bar

To the Felder icons on the Main Menu

To the Main Menu from the Folder icons

Up one line or item

Down one line or item

oo

e Gilia Gy

€
Getting Started
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e
=] Left one position
=] Right one position
[SHIFT {1} Up one screen of data
SHIFT 111 Down one screen of data
LSHIFT I~} Omne word to the left or one screen o the left
[Seim 1] One word te the right or one screen to the right
{cirL) To the hrst item in 2 file
CCTRUIT 1 To the last item in a file
SIS
{CTRL Y (=] To the left margin of the screen

CTRL) =) To the right margin of the screen

To select a function or information in DeskMate using the keyboard, use the arrow
keys to emphasize the desired function, and press (ENTER . If you choose a function

t has & menu, it will appear, and vou can then celect an option by using the arrow
kevs to move to the desired option and pressing {ENTER |.

you cen perform the functions with numbers beside them without accessing the
menu. Select the information with which you want to use the function, and then press
2.7 | number, This method is most convenient when you are familiar with DeskMate.

Some Color Computers use [@ ] instead of [ALT] and {CLEAR | as {CTRL .

Typing Text

You can use DeskMate as you would a typewriter to enter text in any application.
Below are two things you need to know when you are typing with DeskMate.

Use: To:

s Switch between insert/overstrike

gt

[CTAL LG Switch between upper/lowercase

Getting Started
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In insert mode, characters you enter are inserted at the cursor position, pushing exist-
ing characters toward the right. The cursor appears as a vertical line positioned
between two characters, at the point where characters are inserted.

In oversirike mode, a character you enter replaces the character under the cursor. The
cursor appears as a reverse block.

When using Jowercase, you can hold down [SHIFT | while typing a letter to capitalize it,
much like a SHIFT key on a typewriter,

Using the Mouse/Joystick

If you use a jovstick, note that you must plug it into the right joystick port on your
computer. (For detailed information on setting up and using your mouse or joystick,
read the manual that accompanies it.)

When you use a mouse or joystick, a small pointer appears on the screen, and you can
move it around to select DeskMate functions or information. You need to be familiar
with the following techniques for moving the pointer:

point Move the mouse or joystick unti! the tip of the pointer rests over the
desired object.

click Quickly press and release the button.

double click  Click the button twice consecutively.

(SHiFT ) click  Hold down the [SHIFT} key and dlick the buttons
press Press and hold down the mouse or joystick button.

drag Press and hold down the button while you move the mouse or joystick
in the desired direction.

10 Getting Started
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To select a function or information in DeskMate using a mouse or joystick instead of
esired functon or information, and then click the button

the keyboard, point to the

on the mouse/joystick. If you choose a menu function, the menu will appear, and you
can then select an option by pointing to it and clicking.

You can perform the functions with numbers beside them without accessing the
menu, Select the information with which you want to use the function, and then press

TALT ) number.

The chart below shows how to use the mouse/jovstick with a Menu Bar's function

arrows. You m
with DeskMate.

Pori=t to:

0

o0 030

o0 o0 OO0

Then:
Click

Click

Double Click
Double Click

Double Click

Double Click

av need to consull it from time to Hme untl you become more familiar

To move highlight:

Up one line or item
Diowr one line or item
Left one positon

Right one position

Up one screen of data
Down one screen of data

One woerd to the left or one screen to the
left

One word to the right or one screen to the
right

To the first item in a file
To the last itemn in 2 file
To the left margin of the screen -

To the right margin of the screen

Getting Started
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Copying the Diskette

At this point, make a copy, or backup, of the DeskMate diskette in Drive @. This is one
of the most important things you can do as you use DeskMate. If you keep backups of
the DeskMate diskette, you'll always have current information stored in case a mishap
(such as 2 power failure) occurs. Before you continue, turn to the backup instructions
in Appendix A, and make a backup of your DeskMate diskette. Never use your origi-
nal diskette to run DeskMate. Do not modify the original in any way.

To store the greatest amount of information possible while using only one drive, we
suggest that you make two backups. On one backup, delete half the application files,
fsllowing the instrucions about deleting files in “The Files Menu,” in Chapter 4. On
the second backup, delete the applications that you didn't delete on the first backup.
is way, you create two diskettes with more space on each disketie.

5

y

If vou are using more than one disk drive, we strongly recommend that you use a
backup to run DeskMate and 2 data diskette for storing any files you create. Instruc-
gons for creating a data diskette are in Appendix A,

After you've backed up your DeskMate diskette and know how to move around on the
screen, you're ready to see some ways that you can use DeskMate. First, finish read-
ing this part of the manual. The remaining chapters contain important information
vou'll need for working through the Sample Session or for jumping right into
DeskMate,

17 Getting Started
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Chapter 4

The Main Menu

Meny Bar

The Main Menu is the control center for the entire system, enabling you to access any
part of DeskMate you want to use. It is divided into three parts: the Menu Bar (con-
raining functions), the Directory window (showing the contents of a program or data
ioider), and the Folder icons (used to select different data or program foiders). The
contents of Program Folder #3 alwavs appear in the Directory window when you first
load DeskMate. Remember that only mouse/joystick users can access the scrolling
arrows on the Menu Bar.

e

If this is your first time using DeskMate, do not try the functions explained in this
chapter immediately. Read through the chapter now, or skip to the Sample Session
and refer to this chapter when you need information about the Main Menu and its fea-
tures. You can press (BREAK] to cancel 2 Main Mernu procedure you might be trying
and return to the Main Menu.

Getting Started 13
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The Menu Bar

s
\

A Menu Bar, like a restaurant menu, contains various items from which vou can
choose. You can reach the Menu Bar in one of two ways:

[ %e

Keyboard: Press (a7 (7.

Mouse/Joystick: Point to the file or functon you want, and then dick to select it.

G

% The Files Menu

Choose the Files Menu when you want to perform a task involving a program or data
file. First, select the desired file on‘the Directory window. Then, select Files fom
the Menu Bar.

.

s

[ )

When the Files Menu appears, you can move to the option you want and select it. The
options are:

open Opens the file you selected. (You can also open a file by selecting its
icon and pressing or by pointing to the icon and double click-
ing.) If you are opening a data file, its associated program is opened at
the same time. The main screen of the program (with the chosen data
if you cpened a data file) is displayed.

close Exits DeskMate.

&)

Getting Started
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The Main Menu | 4

Makes a duplicate of the selected file.

Icopy

Follow the instructions below to copy using the keyboard: B

1. Move to the file you wart to copy, and then select copy from the
Files Menu on the Menu Bar.

2. A window appears, and you can edit the name of the file you are
csp} ng. {(You cannot change the name of a program file.)

3. When the information is correct, press [ENTER | to copy the file. Be
sure that, if you are using more than one c’usk drive, you have a
formatted diskette in the second drive.

{ vou are using one disk drive, the copy folder number and file-
name must be the same as the destination folder number and file-
name. The following message appears:

Folders and files are identicel
iz 1his & single disk copy?
o Yes IN
4. belect an opton, and press (ENTIR | You return to the Main Menu.
Press 8R! 1o cancel the copy option and retwrn to the Main
Menu
Foliow the instructions below to copy using the mousefjoystick.
’ 1. Move to the file vou want to copy, and hold down the button on
the mouse/joystick until the box changes its color.
l’r ’
15
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If you highlight a program f{ile, the data folder icons disappear. If

you highlight a data file, the program folder icons disappear.

!\)

Drag the box (representing.the file} to the folder to which you
want to copy the file.

ek SR s

3. Release the bution when the box is at the correct folder.

%
® Follow steps 2 thr ’\Lgh 4f kevooard users to complete the copy
procedure. Click wherever [ ENTER | is mentioned.
Soeiele Deletes the selected file.

Follow the instructorns below to delete using the keyboard:

1. Move to the file you want to delete, and then select delete from
the Files Menu on the Menu Bar.

e

A window appears showing the informaton on the file,
2. Press [ENTER | to delete the file and return to the Main Menu

Press [BREAK | to cancel the deletion and return to the Main Menu.

P iy s

16 Getting Started
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Foliow the instructions below to delete using the mouse/jovetick,
24 163

1. Move to the file vou want to delete, and hold down the button on
the mouse/joystick until the box changes its color.

gx?

Drag the box to the “trash can” icon in the lower right corner of
the screen.

R — Keieabiond [
\

3. A window appears showing information about the file.

4. Point to [ERTERI and click to delete the file and return to the
Main Menu.

Point to [BREAKI and dlick to cancel the deletion and return to
the Main Menu.

bussitipodp

e rename Renames the selected data file. (You cannot rename program files.)
Move to the file you want to rename, and select the Files Menu from
the Menu Bar. After vou select rerame from the Files Menu, a win-
dow appears, and you can type the new filenarne. Press [ENTER] to

rename the file, or press {BREAX %0 cancel the rename opton and

i

ket

refurn to the Main Menu.

o

7etlal Displays the date and time at which the file was last updated, its
name, and its size in characters (bytes). Press any key to return to the
Main Menu.

_—

7 help Displays a help window that features spedific instructions for using the

Files Menu. Press any key to see the next page of help information.

e | Press [BREAK], or move the pointer outside the help window and click
to retwn to the Main Menu.

Press {BREAK |, or move the pointer cutside the Files Menu and click to exit the Files
L BAEAK

Menu.

T o

17
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The Folder Menu

. Choose the Folder Menu to print a list of files in a folder or to sort data folder files.

Firsi, select a folder.

Keyboard: Press [AL1 ) (=), chocse the desired folder, and press [ENTER ).

Mouse/Joystick: Point to any folder icon and click.

After you select the program or data folder, move to the Menu Bar and select

Folder,

'W n the Folder Menu appears, move the highlight to the option you want, and press

£ R; or click,

(3]
o
73
4o
e’
L

Prints the filename, creadon date, and size in bvtes of each file in the
selected folder. If you selected a program folder, the information for
eac ch program f file and its assodated help file is printed. When printing
complete, the Folder Menu disappears.

[

Sorts all files in a selected data folder either alphabetically (alpha) or
by program type (icon). Select the way you want the folder to sort. You
return to the Main Menu.

Displays a help window that features specific instructions for using the
Folder Menu. Press any key to see additional pages of he}p informa-
tion. Press [BREAK], or move the pointer outside the help window and
click to return to the Main Menu.

To exit the Folder Menu, press [BREAK), or move the pointer outside the Folder Menu

and click.

18
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The Disk Menu

ot

Choose Di sk from the Menu Bar when you want to initialize or back up ac¢ :x.s}\etﬁ‘e or
when swapping DeskMate diskettes,

=
3
5
§ Move the highlight to the ophon you want to use, and press [ENTER | or click.
4 ir:tislaze Inddzalizes (formats) a diskette for storing informadon. (See Appendix
§ A for detailed instructions.)
backup Makes a copy of a dickette. (See Appendix A for detailed instructons.)
@ 5wEp Enables vou to exchange a DeskMate program diskette for another.

The new diskette must also contain DeskMate programs.

Displays a help window that features specific instructions for the Disk
Nenu. Pres any key to see additional pages of help. Press [EREAK,
move the pointer outside the help window and dick to return to the:
Main Menu.

T
~3¥
J
o
v
o

o The Help Window

Selecting 7 from the Menu Bar accesses a help window containing spedfic information
2 bout the Main Menu, Press anv key to see additional pages of help information. Press
| (EAZAK ], or move the pointer outsi slde the help window and click to return to the Main

Menu. Y rindow.

Getting Staried 19
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; The Scrolling Arrows

Select (Yor Dx{only if vou are using a mousefjovstick) to highlight the program or data
3 icons that appear above or below the information currently highlighted. Point to the
: scrolling arrow that you want to use, and click. For more information about the scroll-

ing arrows, see Chapter 2, "Moving Around.”

AL

The Icon Bar

one ¢f these methods.

e
-
o)
W
i~

Select the icon bar {+) by

59

S

_ oy Ty
Kevboard: Press (A7 1 “ 1.

o RS

4
Mouse/Joystick: Point to » and click.

The Icon Bar contains utilities that you can use at any time while using DeskMate. If
you don't want to select a utility, you can reselect + to return to the application. The
next section, “lcon Bar Functions,” explains each Icon Bar utility in detail.

[or—

G o

P

The lcon Bar contains six utlities that vou can use at any time, in any application.
(Onlv four of the six functions are available in the Paint application.) Select the Icon
Bar from the Menu Bar of the application you are currently using.

o Cursor icon
Folder Calculator Contro! Bar
Y \

3

\ Printer %\ Tirme Dispiay
\ i
!

[

Getting Started



3

The Main Menu |l 4
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o use a utilifv, select its representative icon. To return to the application you were

% ) LSING, press (BRIAK . You can return to the lcon Bar by reselecting it. You can choose
< the help window (7) from the Icon Bar before selecting an icon Bar function.

3

3

)

3

. work with the folders beir ng used by DeskMate. Working
i technical. We suggest that you become familiar with 0S-9 by
laining it an d by reading Appencax C in this manual. After
5

L o

Uit

s

L

L

A pathname identifies 2 folder created by the O5-9 operating svstem and always
% begins with a disk drive number foliowed H\ a name. 1t aiso g;nw d‘ ctions to
| DesiMate and 059 on how to find an existing directory or where {0 put @ new one
on the disk

Note: OS-9 is the computer operating svstem that DeskMate uses.

&
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You can type the names of one or more folders being used by DeskMate, s
existing dircctory (the O5-9 system term for “folder”), or create new directories (thus
creafing an empty folder).

If vou enter a pathname for a folder that does not exist, you are asked if you want to
create a new directory.

Caution: Once you create a directory, vou cannot delete it unless you have an 05
9 systern diskette.

Afrer the directory is created, voy can enter ancther pathname. Refer to Appendix C
for moere specific information about the OS5-9 operating svstem.

The ophions on the Folder utility screen are:

v

ecit Lets vou change the directory information for one or more folders. Be
sure the check is at the edit option, and press (ENTER] or click. Use

the arrow keys and [ENTER], or point and click to highlight the folder
vou want to edit. When the information is correct, press TENTER | to
record the changes, or press | BREAK ) to cancel the edit option. You can
then choose another option from the Folder utility.

R I l\J;S
check is at the done option, and press (ENIER | or click. You return to
the application vou were using.

Sare Tells DeskMate that all information for the files is correct. Be sure the
3

carcel Cancels all changes vou might have made while in the Folder utlity.
(You cannot cancel a created folder.) Be sure the check is at the
cancel option, and press (ENTER| or click. You return to the applica-
tion you were using.

-3 Printer

The printer utility lets vou define information that determines the way your printer
and DeskMate will interact. Select the printer utility from the Icon Bar.

Getting Started
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4 Left Margin Printer line wigth

-

™% -Top Margin
_,/ -

Printed lines

" per page

A/Tota! lines
er page

EN- S S

[Eok EE

B

[ 50 e 7 @ 1 1 3 2
b vron o i 020 W w0 0 e

i You can type over the existing default value and press (ENTER |, or press [ENTER | alone to
i move to the nexi prompt
- cefl mzrgin The number of spaces from the left edge of the paper to the
¥ first character position for printing.

Frintec line The number of characters that you want to print on one
1 wictih line
F

TopMarg:n The number of blank-iines vou want to leave at the top of
3 each page
e . ,

Printed lines per  The number of lines you want printed on each page.

page

H -
8 foial lines per The length of the paper in print lines :

s e e

page

etting Started
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5 vou use your computer as a hand-held

- or click on the cont:nucus option to indi-
cate that you are using continuous feed paper. Move the
“check” to the single sheet option if you want to stop
the printer after each page to insert another sheet of paper.

The number of characters that your printer is capable o
printing on one line of vour page. This is usually set at 80
or 132 columns. Press [ENTER ] when the setting is correct.

Type /P to select the printer port, or type a filename to
“print” information (send output) to a text file.

and return to the application vou were using.

s and returr: to the application vou were using.

pa

1
1S

calculator. You can

et d
hile using any DeskMate application without interrupting the

3

[w}

ently using. The calculator uses a ten-digit display (no commas)

g t. 9,999,999,999 is the largest number that you can
enter or accumulate, and 6.600000001 is the smallest,
After vou select the Calrulator utility from the Icon Bar, the calculator appears,
;f" ¢
RHCR7RENON/BS
IHREJESRORXBEER
FLEL BE B K3 ORI OLYTE
s RON. B - JEDR
24 Getting Started
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g Changes the sign of a number

~C Clears memory contents.

MR Recalls and displays memory contents.

M- Subtracts a2 number from memory.

- Adds a number to memory.

lE Clears current entry (operand) for easy correction.
LA Clears accumulator amount and resets operator.

Revboard: Type the number or function (for example, M- to subtract a number from

Mouse/Jovstick: Point and click to select a number or function.

To change the sign of a number you want to enter, select S
Press [BRtAn ! 1o exit the Calculator utility and return to the applicafon you wer
using.

it vou set the date and time, resetting the date and time you
the startup of DeskMate. (You can see the date a*\d time that vou created
‘e when vou view the status of the file.) Select the Time utihty from the
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4/ The Main Menu

Press [BREAK]! 1o cancel
Press [ENTER) 1o continue

; tvpe the new date (up to 8 characters) and press

Enter the time in the format vou choose {up to 11 characters). For example, vou could
tvpe 12:36 P .M., 12 AM, or 12:36:03 2B

n DeskMate. Use only the hours 1-12,

Y

prompt, the informadoen is recorded, and you

J

Press (BREAK] to keep the old date and time and return to the application you were
using.

Use this utility to change the background and character colors on the screen. Select

the Display utility from the lcon Bar.

Frecss [GSPACE] to see
di=pley cptlticons
Presz [ENTERI 1o continue

the box in the center of the screen. Use the

t ¢
to display other color sets from which you can choose, or click when

. is highlighted. The color sets are:

26 Getting Started
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«  Black characters on a white background with colored icons and screen borders

»  White characters on a biack background with colored icons and screen borders

When the color set you wan! to use is displaved, press [ENTER , or click when [ENTER]
is highlighted. You return to the application you were using, which appears witt h the
_— S P
newly chosen color dz»ptav. You can also press [ BREAX ] to return to the application and
use the existing color display.
Note: This utility is not available in the n because it has its own
display optons with & more extensive assorime t of ¢ ‘r om which to choose.

Cursor Control Option

. which vou intend to run Deski

ousefjovsick to choose the dewce vou want
"11""1 io the apohca don n you were usin XOJ can use the

o}
B
o
o
[
. 6
=1

™ 1

bie in the Paint application because Paint has its own

cursor -:ievice op jons.
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: re
The Help Window

Selecting 7 displavs a help window containing specific information about the Icon Bar.
Press any kev to see the next page of help information. To exit the window:

Kevboard: Press [BREAK ).

sefjoystick: Move the pointer outside the window, and click.

v
Ms

Y0ou return to the icon Bar and can make another selection.

clect this icon to return to the applicaton vou were using without making a selechon
1

Now that vou've read through “Getting Started” and have made a backup of your

te diskette, vou're ready to continue with the Sample Session. If vou need

CRS ]

— U

s

DeskMa 3

help, vou can refer to this part of the manual or to a specific chapter in the Reference
part

28 Sample Session
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This part of the manual is designed to help vou become more
familiar with DeskMate and let you have a itte fun, t00! You can
start at the beginning of the exam iples and work vour way
through each one, or choose 2 particular application that vou
wan! help with. While w“m@g through the e>*:’r;L-, vou 'n:gb*
want to add more sempie data or try other features of the appli-
cetion that aren't covered in this part. To use an application to its

full capab: 'jt}', consult the Reference part.

You are asked to “select” or “choose” applications and functions
in this part, so if vou are unfamiliar with the kevboard or mouse
joystick technigues, refer to “Moving Aro ound” in Gehmg

Siarted.”

As vou go through the Sample Session, make frequent backups of
vour DeskMate dzs}wtte, If you accumulate so much data that the
disk becomes fuli, you can use a backup and delete any data files
you don’t need. I vou are using more than one disk drive, we
strongly recommend that vou use a data diskette in Drive 1 to
store the information you colect while working in the Sample
Session. See Appendix A for instructions on creating data

diskettes.
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Beginning the Sample
Session

Before vou start the Sample Session, you must load DeskMate and make a backup of
the diskette. If you haven’t done this, read “Getting Started.”

in Mem your screen. You can access each

application, the Menu Bar, and the Icon Bar utilities by following the directions on the

next few pages. These functions are accessible from any application and are explained
[=d

s
in more detail in the Reference part,

Note: Some Tandy Color Computers may use [ @] instead of [ALT} and [CLEAR)
{ CTRL .

instead of (CTRL]. The manual always refers to [ALT | and

Using the Calculator

Calculator works in the same way as a hand-hela calculator. Follow the instrucHons
below to perform some mathematical calculations such as adding, subtracting, and
multiplving and to see how vou can use the “memory” feature to store and recall

calculations.
o At the DeskMate Main Menu, select the Icon Bar ().
Cursor
Folder Caleulator Coiitrol

Display

rmole Session | Main Menu 31
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lculator utility from the lcon Bar.

Add the fellowing figures and place them in memory.

12.93, 38,70
Keyboard: Type 12.93 MM+
Type 38.7¢ M

{You do not have to press [ENTER |.)

Mouse/Joystick: Point and click to each digit in the first number vou're adding.
Then point to M+ and click to enter the figure into memory. Enter the other figure

in the same manner. N
Select ME to see the accumuiated total of the figures you entered.
Keyboard: Tvpe MR

Mouse/Joystick: Point to MR and click.

The total should be 51.63.

Subtract 50.00 from the total you have in memory.

Keyhoard: Type 5€.60 M-

D

mory shouid be 1.63.

h
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s
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beginning the Sample Session /' 5
e : e ]
Z Multply 6bv &
Keyboard: Type 6x 9 = -
Mouse/Jovstick: Foint and click to the numbers and operators.
The answer {24} appears in the calculator window,
T Now check to see if the previous total that you entered into memory (1.63) is still
there.
Keyboard: Type MR
MouseJoystick: Point to MR and click.
T Clear the amount from memory.,
Keyboard: Type MC
Mouse/Joystick: Point to MC and click.
The amount (1.63) is now erased from memory. 1 .&2 still appears in the calcula-
tor window.
= Exit the Calculztor utility. ‘
Kevboard: Press [BREAK |,
MouseJoystick: Point to BRK and click.
You return to DeskMate’s Main Menu.
' 33
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w
Setting the Time
You can use the Time utility on the Icon Bar to reset the system date and time.
4 At the DeskMate Main Menu, select the Icon Bar.
3 — Select the Time utility from the lcon Bar
Dstle 1%
Time 151
Frese [EREAK] lo cancel
Press [ENTERI 1o continue
. T Type 1/1/1986 or 1/1/86 [ENTER | for January 1, 1986.
3 You can enter a date of any format within the & spaces provided.
4 T Now, tvpe 2:58 PM [ERTER ) to set the time.

You return to DeskMate’'s Main Menu. The system date and time are now set to
the entmes you made above. Any files you create now will show these settings
when you view their statuses. When you enter the Calendar application, January
1, 1986, will be highlighted.
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Chapter 6

F O thd
ups, and house maintenance duties. The more vou consult Calendar, the more uses
vou will find for it. Just keep in mind that virtually anyvthing vou rmught want to
remember can be easiy recorded in DeskMate's Calendar!

Entering the Schedule

— Select Calendar from the Main Meru. .
After vou press [ENTER | or click, the screen appears as below:

Menu Bar

Calendar

3
w

Sample Session / Calendar
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Calendar functions, & help window, scrolling
ach day of the month (with the
text area is like a

~,y

current day and da screen). The
. notepad on a desk calendar. You can jot down vour entire schedule for the selected
:f dav
T2 Move the highlight to a day.
- .
g L Move to the Calendar Menu Bar and select Text.
;
Ed
{]
i
— Select ec:t from the Text Menu.

Gy

[

After you select the edit function, a cursor appears in the text area.

the edit function, vou are in overstrike mode, indicated

When vou are in insert mode, the cursor is a vertical
(A7) [ switches between the overstrike and insert
upper- or lowercase.

Note: When vou first enter

by the flashing cursor block.
line berween two characters. [ALT
modes. [CTAL] (2] switches between typing in all u

SR
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~ Type
— Type

9:30 AM Project meeting | ENTER | -

ENTER |

12:3¢ PM Lunch [ENTER

LENTER |

5:3¢ PM Cleaners [ENTER]

LENTER |

prgpryraree . TR

8:60 PM Dinner Party [ENTEF |
As vou type in the iast entry, the screen scrolls up one line so you can see the line on
which vou're typing. You can scroll back up by using the (7] on the keyboard or the {3

on the text Corm-n d Bar (if you are using a mcuse@o; stick).

Exit the edit function and return to the calendar area.

Keyboard: Press [BREAK .

Mouse/Joystick: Point to ex it on the text Command Bar and click.

T Use the methods described above to select another day from the calendar area for
entering a schedule,

T Return to the text area and type the followin

B:80 AM Breakfast meeting | ENTER |
(ENTER
12:45 PM Lunch | ENTER
an PR
6:30 PM Soccer game | ENTER |

T Re*turn to the calendar area.

w
~1

Sample Session | Calendar
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inting the Schedule

Select F1le from the Menu Bar.

Prant W day T week
menih T oall

To move the “‘check” to month, use the arrow keys on the keyboard and press

(ENTEA |, or use the mousefjoystck to point and click.

When the printer is finished, you return to the main Calendar screen. You now have a
sample printout of schedules that you created.

Finding An Entry

T Select Text from the Menu Bar.
T Select fing from the Text Menu.
Type Meeting [ENTER .

The first date containing the word “meeting” is highlighted, and the text of that
date is displayed.

Calendar / Sample Session
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Now, press (1, (7 [ENTER to see the next ‘meeting”’ on vour schedule.
(a7 (7] is the “shortcut” method of selecting the find function. Pressing [ENTER

accepts “Meeting”’ as the word you want to find again.

@

ing Calendar

Press [BREZaK_ te exdit the Calendar application.

B -2 ~ i
[SaiShuadi I

Move the check to ne, and press [ENTER | or click.

You return to the Mzin Mznu.
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Writing a Letter

Think of the Text Editor application: as a2 blank sheet of paper in a typewriter—ready
for you to fill with words of poetry, correspondence to friends or businesses, or those
hard-to-find grocery lists. You can even send pages of text using DeskMate's Telecom
application. In this example, vou will write a letter and then print it. We suggest that
vou type the text offered in this chapter so that you can use the editing techniques

YO Uy O
presented. Later, you can experiment with your own text.

122

Composing the Letter

T Select Tex

\Menu Bar

Text Area

Use the main porticn of the screen like a blank sheet of paper. The Menu Bar contains
access to the Text Editor functions, a help window, scroliing arrows, and the lcon Bar.

(83
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Writing a Letter / 7

k s
§
k1
ad
. Type the following letter on the screen.
E * g
4
3 Jenusry 1, 1286 [ENTER] -
CENTER |
Dear Pat, |ERTER
f | ENTER |
: You ll mnever believe 11, bul I'm wraling this to you o6n the
, new Tandy Color Lomputer | got for Chraistmes. Jt's really a
g sreek from the robee &nd erfume that | us*_‘ally get, and m
naving leis of fun witkm 1t v PENTER!
VENTER |
3 I can ce 50 much with this DeskMate program. [‘m using lhe
; Texi Editor now, butl | cen alse keep f1iee, creste & budget,
el reminoers to myself in Calendar, and even paint! | couid
3 zend this letler lo ycu within secercs ¢f wriling 11 :f you
g rec a computer (with mooem) loc. [ENTER]
k gy arane]
i ENTER |
? top typing the letter for a minute and follow the instructions below to use
i backspacing to edit a portion of your letter.
*
,u% T First, move the cursor to the word “with” on the last line of the letter.
3 -
— Typeand )
7 Be sure the cursor is one space to the night of the letter =, and press {ALT |~ | (for
backspace) to delete n

— To close the extra space between enc and mocdem, move the cursor one space to

3 the nght-of the extra space, press (ALY (! (to begin using insert mode}, and then
g ress (A7)0 - ) again to delete the space.
press LA - again (o aeiete P

. Press (A1) [1] to return to overstrike mode.

7

Sammle Session / Text Editor 41
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7 ! Writing a Letter

T

Ui

(S R

Now, continue tvping the letter.

-
Why con’t you talk 1o Jeohn aboul ceti:ing & Tandy Color
Compuler, He can use 11 loo -- for the new business! [ENTER]

R

ENTER
Mt st
Just think! Ho more stamps or letters Jlost :in the mail. And
tt’e chesper than a lelephoene calll [ENTER)

for now and iry some more pregrams. Wraite

You can scroll through the letter by using the arrow keys on the keyboard or the Menu
Bar arrow keys with the mouse/joystck.

Editing the Letter

If vou made a mistake while typing the letter, you can use [ALT] (-] (backspace) to
delete letters as you saw in the above example. You can also edit by moving, inserting,
or deleting blocks of text. Foliow the instructions below to reverse the order of two
paragraphs in the letter you just typed.

— Move the cursor to the first character in the paragraph that begins, “Just
think . . ."” )

Keyboard: Use the arrow keys to move the cursor.

MouseJovstick: Point and dick.

2 Text Editor | Sammple Session
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— Highlight the entire paragraph.

i,

Kevboard: Move to the Menu Bar and select E

it

arrow keys to highlight the paragraph.

MouseJoystick: Hold down the button on the
light until it covers the paragraph.

R Et
|
|

Aove to the Menu Bar and select Block,

kit

The biock of text remains on th Teer, bui i
i reserved pol ' }
3 choose.

Fre

be to the right of the word “foo.”)

5

3 T Select :nezrt from the Block Menu,
A

f

it

i

lcck. Then chocse zele
the Block Menu. (You can also press (A7) (&) to begin the selection.) Use the

m

Move to the Menu Bar and select Block again.

t from

ouse/joystick, and drag the high-

it 1s also stored in a copy buffer (a
naced in any area of the text that you

Now move the curser to the end of the second paragraph. (The line cursor should
e
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7/ Writing a Letter
i
[ Eremrocorcs arse i s

_ Move the cursor to the second occurrence of the paragraph that begins, “‘Just
think .. .” -

P

) 7 Move to the Meru Bar and reselect Block.
: 7o Choose select from the Block Menu.
: T Highlight the entire paragraph
3
— Move to the Menu Bar again and choose Block.
: T Gelect delete from the Block Menu.
&
2
%
&
z
g
g
=
,_;%
3

The text that was highlighted disappears. The paragraphs appear in their new
order, and you are ready to print the lefter.

]

3
5

Text Editor / Sample Session
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Writing a Letter / 7

Printing the Letfer

If you have a printer and want a copy of the letter you just created, follow the instruc-

4

trons below.

o
ig,

Move to the Menu Bar and select 73

— Select print from the Fie Menu.

After your printout is completed, the letter reappears on the screen.

Exiting Text Editor
When vou are ready to exit the Text Editor, follow the instructions below.

File.

T Move to the Menu Bar and select

T Select ¢ lcse from the File Menu.
TN
Main Menu.
Sample Sessiom | Text Editor &5
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Chapter 8

Creating a Mailing List

The exerase below will help you become more familiar with the Index Card applica-
tion. You'll learm how to set up a mailing list—from developing your own format to
adding and deleting names on the lis{. Use Index Cards as vou would use ordinary 3 x
5 cards, tucked away in appropriately labeled boxes. The wonderful difference is that
with DeskMate, vou won't ever have to look for a lost box or take up predous room in
vour closet or office with box upoen box of filing cards. Also, each time you add a new
card, DeskMate automatically alphabetizes all the cards.

Laying Out a Format

T Choose Index Cards from the Main Menu.

- -

his screen shows blank cards and prompts you to enter a fAlename. You must enter a
¢ create a card format for the new file before vou can access the index

Index Cards / Sample Session
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n
—

Now you are ready to create a format for the mailing list. A format is the way you

want the card to look on the screen.

Enter the edit characters for the phone number by following the instructions below.

Sample Session [ Index Cards 47
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Use the up arrow to move back to the phone number line.

T Press [SriE ) [=).
0 Tvpe { and then use the right arrow key to move three spaces.

— Type) and usz the right arrow key to move three more spaces.
~ Type — [ENTER).

Select Formeat from the Menu Bar.

Choose ex i1 from the Format Menu.

You retumn to the main screen for.Index Cards. The filename (MLIST) now appears
at the bottom of the screen. Follow the instructions below to add data to the mail-

ing list.
Creating or Adding Cards

Move to the Menu Bar and select Card.

L

The Card Menu is for viewing cards, inserting new cards, printing the information on
the cards, deleting cards that you no lenger need, and changing the format. You'l
that some of the selections show only & “shadow.” This means that the func-

notice

Hon is unavailable at this time. After vou add data, these functons will appear as the
others. '

48 Index Cards ! Sammple Session
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Ty

Select 1 nsert from the Card Menu to add information to the mailing list

\
'

Sylernisi Bt

|

Type the following names and addresses in the format you just created:

1
3

39‘?11’1501 LENTER |
Ray [ERTER |
4000 Main Street [ENTER!

Note that vou do not need to include the parentheses and hyphen in the phone num-
ber because they are part of your format. The cursor will shp by them on the screen.

%

Move to the Menu Bar and choose the edd functdon from the Insert Menu.

The data you just entered is recorded on your disk, and you have a blank card so
that you can add another name to the list.

(994

B

R

5

Ll

[EREWWIEE 3
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Ft ?wcrnx Eh*i
Texas | ENT EE:.
76018 [ENTER )
8175554591

Choose add again to add the name you just typed

Type:

Petta [ENIER

Linen \Ehl»ﬁ

6581 B,ackwood L ENT (ENTER
Ft. Worth [ENTER |

Texas ! FNJER ]

73092 | =N

8175553249

Choose ex:11 to record the name
main screen. '

to the mailing list.

and return to the Index Cards

Jphnson

Dominigus

Index Cards / Sample Session
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Creating a Mailing List / 8

The main screen for Index Cards now shows the names vou entered, filed in alphabet-
ical order by last name.

Editing Data

Periodically, you'll need to update information on your cards. The exercse below
shows you how,

T Highlight the name, Ray Jehnsen, from the index cards.

T Select Carc from the Menu Bar,
. Select view from the Card Menu.
i Move to the street line and type:
380 Taylor Street [ENTER )
T Move to the Menu Bar and select File
Z Select exit from the File Menu.

The record is automatically updated, and vou are returned to the main screen of Index

%

3
TES.

Deleting a Card

wy
.,
[§3
3
e
o
j1:]

8]
[ 8
jmp
g
o,
[at)

4

oy

(0]

o}

[t

o)

%)

e
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Select delete from the Card Menu,

3
i

1 e,

RS

W

T Select Fale from the Menu Bar
Py
E — Select close from the File Menu
T i just created is now stored on disk by the Index Card program

a you j
der the file name of MLIST, and the DeskMate Main Menu appears.

St

Index Cards / Sample Session
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Searching for Data

Follow the instructions below to find specific information in an index card file named
S=mple orn your diskette.

T Select Folder 1 from DeskMate's Main Menu.

rmny

Keyboard: Press (ALT] | - | to move to the folder window. Then, press [1] twice to

bt
to Folder 1. Finally, press [ENTER |

Nt et

}

Jastoi s

[1¢

MouseJovstick: Point and dlick on Folder 1.

1

Choosing a datz folder lets vou see all of the data files created by DeskMate applica-
nons. Foider 1 now contains two index card files, MLIST and Sample.
— Open the Index Card file named Sample.

e same method as when opening a program file. When you open 2 data file,
the aprlication is automatcally opened.

The Index Card main screen is now displaved showing the cards in the Sample
fite

-

T Seject view from the Card Menu.
Sample Session / Index Cards 33
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E:
2
3 __ Move to the Menu Bar and select File.
9
3 .

- Select find from the File Menu.
‘kg r— - 0 13 . B
3 . Follow the instructions below to set up a search for all birthdays in the month of
| )

July. Type:

VENTER

CENTER )

May=
% -
& —  Move to the Menu Bar and select F 1 nd,
b4

T Select find from the Find Menu.

3{ .
3 You rerurn o the view screen and the first card that contains the word “"Mav.” i

Use [SHIFT ) (= from the keyboard, or click on the right scrolling arrow with the

mousejoystick to see the next card with 2 May birthday.

Btpmantth
{

. Select ext from the File Menu, or pre iEinr'. | to exit the view screen.

NS < 4

The Index Cards main screen appears.

elect ¢ Lose from the File Menu, or press { BAREAK . to close the Index Cards appli-
cation and return to DeskMate’s Main Menu.

J
w

Setnd

¥
&

ki
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Chapter 9

Becoming An Artist

This chapter shows how you can really be creztive with DesklMate's Paint application
4l the possibilides for Paint are 100 numerous to show here, but vou can let vour
imagination soar and find other wavs to use Paint to its full capabilities!
o Yo TP
Drawing a Picture
T Select Paint from DeskMate's Main Menu.
Menu Bar

Canvas

Pencil

anvas. The Menu
n Bar. The “pen-
uch as brushes and

o

(¥
¥
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9/ Becoming an Artist

aint actually works better if you have a mouse or jovstick, but vou can also use the
rrow keys on the key bo rd. If you choose a device DOfO' e vou enter the Paint applica-
tion, the program knows whi ch method you are using. i vou chose, at the Main
Menu, to use a mouse/ioystick but want to use the key board to perform this sample
session, you must perform a preliminary step.

e

Y

i Move to the Menu Bar and select Edat,

L

 Select gevice from the Edi

=
I
s
=
=
o
~
Q
e
o
O
o
n
2%
ry
[13]

keyboerd only
joystick
mouse or Joystick

T Be sure the highlight is on keyboard, and press [ENIER).
The Paint application does not recognize the mouse or joystick if vou have chosen
‘sosrd as your device,

The screens may show slight differences according to the method you choose. This
exercise uses the mousefoystck techrugues to move around on the screen and to
choose functons. If vou are using the kex board, remem‘*er that to make a selection,
you move the highlight with the arrow keys and press [ ENTER |.

70 Use the pendl to draw on the screen.
Keyboard: Press the space bar once and use the arrow kevs or [SHIFT | plus an
arTow key to move the pendcil around on the screen. Press the space bar whenever

you want to start or stop drawing.

MouseJoystick: Hold down the button on the mouse/joystick and move the pendil
aroun d on tne screen, creaning various shapes and designs. Release the butten to

Pamt / SampLe Session
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Becoming an Artist /' 9

Experiment awhiie using the penci to draw, and then clear the screen as instructed
below,

-
— Move to the Menu Bar and select Ec11

77 Select clezr from the Edit Menu.

The canvas is once again blark, and you can

Drawing a Circle

Select the background color by pressing [ENTER | or by clicking.

on to the next exercise.

v easy to select tools ana patterns to enhance your drawings. For example, to draw a

~rele and fill it with colorful

T Select Teol from the Menu Bar.

/
ext Magnity

Eraser

vou use to apply the “paint

&
patterns, foilow the directions below.

Brush

Select Heip

rt

to the camvas.

-1

w\
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9 / Becoming an Artist

Place the cursor near the center of the screen.

Keyboard: Move the cursor to the center of the screen and press the space bar.
Mouse/Joystick: Move the cursor to the center of the screen and click.

T Maneuver the drde untl it fills most of the screen,

Keyboard: Use the arrow keys to maneuver the crde. Press the space bar when
the ardle is the way you want it

Mouse/Joystick: Move the mouse or maneuver the jovstck control, and click the
) 1%

bution swhen the drcle is the way you want it
Now vou are ready to fill the cirdle with a pattern.
™ Move to the Menu Bar and select Tool.
Select F: 1! from the Tool Menu.

. Move to the Menu Bar and select Palette.

These are the patterns from which you can choose to fill the circle.

Select a pattern.

Keyboard: Use the arrow keys to move the highlight until it rests on a pattern that

vou want to use, and then press [ENTER | to select it.

Mouse/Joystick: Move the highlight around on the palette until it rests on a pat-
tern that you want to use, and then click to select it.

The palerte disappears, and a cursor appears on the screern.

58 t / Sample Session
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Place the cursor inside the circle and click the button if vou are using a mouse/joy-

stick or press the space bar if vou are using the keyboard.

The circle is now filled with the patiern vou selected. Now, erase the circle the same

way vou erased the previous drawing.

Creating With Paint

The next exercise shows how you can be creative with Paint. Follow the instructions

€
below to create a simple drawing of a locomotive.

Select the rectangle from the Tool Menmu,

Create a rectangle that resembles the one shown below.

Keyboard: Press the space bar and use the arrow keys to maneuver the rectang
5

ing point of the rectangle.

G
pad
23
)
m
o
o)
Y_“
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9/ Becoming an Artist

You may have to practice awhile to get the rectangle the way you want it. If vou make
a mustake, vou can erase your work by choosing unde from the Edit Menu and start-
ing over again. Undo erases the last thing that you drew,

Repeat the above procedure for creating the other rectangles needed for the loco-
motive as shown below.

Now, vou're ready to put the wheels on the locomotive.
Z Move to the Menu Bar and select Tool.

Select the circle from the Tool Menu.

60 Paint / Sample Session
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Use the crde tool to place the wheels on the train as shown below.

[N

T

i

b

. —
H

%

i

Now vour train is complete and ready for the finishing touches
Move to the Menu Bar and select Paletite

: Select the solid red patiern from the Palette Menu.

k
E , o ,

7 Sammple Session | Parnt 61
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8 / Becoming an Artist

o

Move to the Menu Bar again and select Tool.
Select f.11 from the-Tool Mernu.

— Move the cursor until it is in a rectangle and click (or press the space bar) to fill
the rectangle with red.

Repeat the same procedure undl all the rectangles are red.

Z Select “spray” from the Tool Menu to draw some smoke coming out of the
smokestack.

The drawing on vour screen should resemble the one shown below.

If vou want to print the picture of the train, refer to Chapter 16, “Paint,” in the Refer-
ence part.

Now vou're ready to create some pictures of vour own, using the many tools and pat-
terns that Paint has to offer.

Faint / Sample Session
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Chapter 10

Setting Up a Budget

This exerdse teaches you how to set up a simple household budget using the Ledger
application. The budget contains monthly expenditures and income and shows the
results of calculations.

R

Labeling the Spreadsheet

Select Ledger from the DeskMate Main Menu.

Manu Bar-.__m
Column
Row
Ceil =

OO b w\»

e s o B D o B Pt

Cell 1.D.

The Menu Bar contains access to various functions that you can use with Ledger.

R

‘wm
FA

Ledger / Sample Session
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Setting Up a Budget | 10

The screen lavout is called a spreadsheet. Although vou can’t see them all on the
screen, there are 99 columns and 99 rows in which vou can enter data. Each cell
{intersecton of a column and row) can contain data of the following 3 types:

number for numeric values only
label for alphanumeric characters
formula for formulas to be used in calculations

ezrnn how to enter datz in all three types of cells and perform functons from
the Menu Bar bv working through the following exercise.

Move the highlight to Column 2 a5 shown on the screen below.

CONNLTE B LI 200 RO NN D L) Mo

B o G B B st o

This is the tile for the budget vou'll create.

(9.2
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&
d
. T_ Move to Row 3, Column 1, and begin tvping the data below.
a
1 ~
g Mortgage (1]

Jtilities (4 |
Groceries | |

Gas [{]
Chg Accts 1)

M

R

Total L

Income (I

Balance

The budget items you entered act as labels for the amounts you'll be entering.

5 ~ Move the highlight to Row 2, Column 2, and type Jan 1 [=.
i - —
— Type Jan 15 (- ] in Column 3.
s —
;: = Type Feb 1 (-] in Column 4.
_ Type Averages in Column 5.
4 Hotce that the spreadsheet “scrolled” when vou moved to Column 4.

. Use the lef#t arrow key on the kevbozard or point to the left arrow on the Menu Bar
5 ) P
and click to scroll left until you see the labels.

1
i
i
1
1
i
%
g
3
;% 66 Ledger / Sample Session
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10/ Setting Up a Budget

. Type SUMI(R3) [ENTER ).

This formula indicates that you want to add the amounts in this column, begin-

ning with the value in Row 3.

After you press [ENTER |, the formula message disappears. The cell now shows ¢F »
to indicate that it contains a formula,

Move the highlight to the Balance row (Row 11, Column 2).
Select Block from the Menu Bar.

Select formula from the Block Menu.

Type R18-R9 [ENTER . ‘

This formula will subtract the total expenses from the income for that peried.

You have entered labels, numbers, and formulas for your spreadsheet. Take just a
moment and move from cell to cell. You'll notice that the bottom left corner of the
screen indicates the type of cell. If the cell contains aiphanumerie characters, it shows
rabel. If you have a number in the cell, it shows number. When the cell contains a
formula, that formula is displaved.

Next, you'll copy some of the information in Column 2 to the other columns on the
spreadsheet.

Copying Formulas

[

Move to Row 9, Column 2.

Move to the Menu Bar and select Block.

Ledger / Sample Session
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Move to the Menu Bar and select Blec

Select copy from the Block Menu.

-

The text remains on the screen, but is also in a copy buffer and will remain there. You
can copy it on the spreadsheet as many fimes as you wish untl vou choose something
t hen the new selection replaces the old information in the buffer.

Move the highlight to Row 9, Column 3.

&

—

Move to the Menu Bar and select Block.
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10/ Setting Up a Budget

The income figure is copied to Column 3, but the cells that contain formulas do not
show amounts until vou calculate.

— Move the highlight to Column 4, and insert the information contained in the copy

.

buffer by again choosing 1nsert.

You don’t have to chocse copy again. The information in the buffer remains there
until you copy over it.

Calculating the Totals

7 Move to the Menu Bar and choose Cells,

70 Ledger | Sample Session
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10 / Setting Up a Budgel

T Select formule from the Block Menu.
T Type AVG(C2) [(ENTER].
The formula is entered into all nine cells.
— Move to Row §, Column 3, and delete the formula in the cell.

Select the delete option from the Block Menu to delete the formula.

Now perform the calculation by following the directions in “Calculating the Totals.”

Printing the Spreadsheet

If you have 2 printer and want a copv of the spreadsheet you just created, follow the
instructions below.

If vou do not want a copy of the spre:ids‘nee press | (: and answer no when
asked if you want to save the file. You return to DeskMate's Main Menu.

* -

Move to the Menu Bar and select File.

T Select print from the File Menu.

After your printout is completed, you can return to DeskMate's Main Menu.

Exit

Pt @
-
§ &
e
D
£
a9
D
L

You can save data files in folders other than the first one. Save this ledger file in Folder
2 by following these instructions.

T Move to the Menu Bar and select File.

N

Ledger | Sample Session
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Sending a Message

Telecom lets you communicate with other computers or with the many computer ser-
vices that are available. In this session, you'll see an example of how you could use
Telecom to communicate with a lar rge ¢ mput& service. dince you can't use Telecom
without & computer service or another computer, just read this chapter now. Then,
’*“E" vou have your modern and are a serwice user, come back to this chapter and try
actully using Telecom. Before u ing Telecom, be sure that vou have read the informa-
ton that came with vour n*o*em, that vou know how to connect it, and that you
know the rmodem settings vour computer service requires you to use. See Chapter 17,
Telecom,” for information on connecting your communication equipment.

m
n

DL
o
>4

Note: You must have a Multipak Interface, a communicztions board, and a modern
to use this chapter.

Setting Up for Communication

Whern you are ready to set up for communication tc another computer, follow these
instruchons.
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R e N ]
T Select Telecom fom DeskMate’s Main Menu

———Status Setiings

The top line of the screen is the menu bar, containing the names of the options you
can use, plus access to a help window and the icon bar. The main part of the screen
contains Telecom’s status settings. Before you can communicate with another computer,
vou need to select the settings that vour computer service requires. The screen above

. e iisivih cee
snows the deraull setings.

i1

Enter your user ID and password as your computer service recogrizes them.
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11/ Sending a Message

e

P

— Set the Word Length, Paryty, Stop Bit, Line Feed, and Echo to match
the settings that your service requires vou to use.

An example of these settings is:

SR B

Word Length: 7-bit
Parity: Even
‘ Stop Bit: 1
% Line Feed: No
&4 Echo: No

|

Tvpe /T2 at the Seraal Port prompt.

Getting Ready to Call

The status screen is only one of three Telecom screens. The other Telecom screens are
the terminal screen and the memory screen. To call (or go “online” with) another com-
puter, you need to be in Telecom’s terminal mode. To enter terminal mode, move to the
. terminal screen.

: Move to the Menu Bar, and select View.

— Choose terminal from the View Menu.

Sk

Telecom | Sample Session
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Sending a Message | 11

Choose memory from the View Menu.

This screen lets you scroll through the information that was tansmitted in the

Da e AU U5 T £ -~ aYOR Y -
ame way you would sared through a DeskMate Text Hle.

w

The contents of this screen will be erased when vou exit Telecom. For this reasorn,
when vou exit Telecom, it gives you the opportunity to save the content ;
ory screen.

(I!
a
=
g
4]
J
0
8

l

d & e
Exiting Telecom
To exit Telecom, foliow these sieps
Z Al the memory screen, move to the Menu Bar and select F1le.
T Select cloze from the File Menu

Save memory? [ yes [ no
— Select no.
You immediately return to DeskMate's Main Menu.
Sample Session | Telecom 79
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This part contains very detailed information about each applica-
tion and function in DeskMate. The information is usually pre-
sented in order of its appearance on the screen (not necessarily
in the order in which it is to be performed).

tup procedures for DeskMate and the kevboard and
ovstick rechrugues are explained thoroughly in “Getting
Started” in this manual, so refer to it if vou need help in those
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Calendar

The Calendar applicaton will replace vour tattered and torn desk calendar. You'll
never be late again or forget a birthday or anryversary because your desk calendar was
buried under paperwork or because you couldn't read the scribble. Your DeskMate
Calendar appears in seconds, and vou can review or schedule events for any month,
day, or year you choose by merely moving the cursor through a monthly calendar

screen. You can also print monthly, weekly, or daily reports if vou need a “‘reminder”
to tzke with you.

Instructions

Choose the Calendar application from DeskMate’s Main Menu.

Menu Bar

Calendar

Texi area

V4

Current gay eng gate
nt

J
When you first enter the Calendar application, the system month and day appear. The
entire ronth appears in the middle, the bottom left block shows the day and date,

and the space to the right displays daily memos (if any). Use the techniques described
in this chapter if you want to move t0 another day or month.

Reference 83
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12 ! Calendar

S B

vienu Har containg variol y
. The File Menu lets vou cpen, close, or print a file. The functions on the
m let you record ‘nfo"ma’lon on z selected day. Use the Date Menu to set the
Vh' on a particular day. Calendar also has elp screerns, s‘.rong arrows, and

¥

'ou can perform in the Calendar pro-
xt

Spcoiictiulal

s {0 the Icm Bar.

i
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7
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| File Manu
(

7 1 1
Text Menu ! Date Menu Help i Scrolling | icon
) Arrows Bar

{
{
{
i
|
i

e

Keyboard Techniques

5 Use the standard kevboard techniques as explained in “Getting Started.” The keys
calendar area:

isted below perform specific functions in the screen’s

To Move the Highlight:

Press:
b3
&
s space bar Right one dav
GRS To the first dav of the next month

Lraditis
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Calender 1 12
g R
. [sHirT ] (-] To the first day of the previous month
i » S -
CTRL (= fo next Januarny
j [cTRL [~ . To last January
Press [ 8RIAX | while in the text area to return to the Calendar area.
% Press [ EREAK | while in the Calendar area to exit the Calendar application.
8 Edit text for the highlighted day by pressing (ENTER | or by selecting ecitl from the
§ Text Menu. While in the text area, the standard kevboard technigues apply
) L .
Mouse/Joystick Techniques
3 Use the mouse/joystick in Calendar as explained in “Getting Started.” Note the follow-
’ ing technigues for using the Menu Bar arrows:
Point to: Then: To Move the Highlight:
o Double Click  To the first day of the next month
1 < Double Click  To the first day of the previous month
3
o [SriT] Click  To next January
CSAFT | Cli ANUArY
. 2 SAIFT | Click  To last January
Double click on a calendar day to move to the text area. You can also reach the text
f area by selecting the Text Menu and then clicking on ed: 1. While in the text area, the
s standard mouse/joystick operations apply.
-

P

ittt
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Choose the File Menu when vou want to open a Calendar file, close {save) the Calen-
dzr application data, print data, or see a help screen dealing with the File Menu. Eact
fiie contains schecdules and information for the day or days for which you entered text.

cpen Opens any calendar file. Move to the Menu Bar and select 7.1
Choose open from the File Menu. A window appears showing the
files (by name) contained in the highlighted folder. Select the folder
(and file) you want and press [ENTER | or click.

save Saves file (by name) and you remain in the Calendar application. After
vou choose save from the File Menu, the message,

save 2%
appears on the screer. Enter the filename you want to use and press
i - - i
{ENTER .

ciose Exits the calendar application and saves any entered or changed data.
After you choose ¢ loce from the File Menu, the message, save? {7
yes T no, appears on the screen. Select the opton vou want and
press [ ENTER J or click.

2 prant Prints text for the current day, week, or month. You can also choose to
print all text. Choose print from the File Menu.

Frant ¥ deay T weet
— monih T omlld
Select the option you want and press [ENiEs
5 Reference
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Choose the
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Displays a help window designed to assist with File Menu functions.

Aeniu

cted daily record.

Inserts a copy of the selected record into a copy buffer for you to use
later. After you select a date to copy, chocse copy from the Text

feriu. The selected record is now in a buffer. Mark another day on
which to copy the record and then choose i1nsert,

Inserts the record from the copy buffer into the selected daily record.
You can use this function only if vou placed a record in the copy
buffer via the copy function, explained above. You can also use [ALT]
(4] to insert. '

Clears all information in the chosen daily record. You can also delete &
range of dates. After vou select ceietle, the message,

Deiete Zicne cay _imore
appears. Select an optio*‘\ and press (ENTER | or click. If you choose one
o=y, the marked day's informat on is deleted. If vou choose more,
vou to enter a date range. Enter the beginning and
hich vou wish to delete information. (&7 (5] alsc
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Finds the first (or next) daily record containing information you

specify.

Find:

At the prompt, enter the text you want to see (up to 20 characters),
and press [ENTER ). The first day containing the text you entered is
highlighted, and the record of that date is displayed. To find the sec-
ond day containing vour specified text, select ¥ 1 nd again. The prompt
and the text you previously entered reappear. Press [ENIER ), and the
second day containing the text is highlighted. You can continue this
process until vou reach the end of your Calendar file. When you next
use find, it will search from the beginning of the file. You can also use
(A0 70 to find text.

.Y
i AL

Lntmar )

If you select this function, a cursor appears in the text area, and you
can enter new information using up to 400 characters or edit existing
information for the date currently displayed. If vou use all the spaces
for every event you enter, you can store only the 31 davs of events.

\3@, ST e

Command Bar

Text Area

Type and edit in the same manner as you do when using the Text
applicaton (but without the “select” and '"block” features). See Chap--
ter 14, ""Text Editor,” for more information.
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Calender / 12

Wher: you reach the bottom line of the text area, the screen scrolls up
1 line so that vou can always see the line on which you're typing. Use
the arrow keys on the keyboard or the Command Bar arrows if you
are using a mouse/joystick to scroll through the text.

To exit the edit function, press [BREAK] from the keyboard, or select
ex:1 from the Command Bar if you are using a mouse/joystick.

* help Displavs 2 window designed to assist you with Text Menu functions.

Date Menu

Use the Date Menu to set the highlight on any valid date or see help information
about the Date Menu.

% find Lets vou set the marker on any valid date. Select {1 nd date from the
dale Date Menu,

Date to Fincg:

Specify a date to search for, and press [ENTER . Normally, you'll want
to use a muvdd/yvy format when entering dates. However, if you
wanted to find a date in 2001, you wouid need to use a mur/dd/vyyy
format. The marker is then set on that date and the text information (if
ary) is displayed. [ALT} (T aiso finds a date.

Displays a window of information toc assist vou in using the Date
Menu.

Reference 89



Vit

¥R

i RS

i sw

& SRR

St

.

it T—— Sl L3

e e

12 / Calendar

Help Window

Use the help window when you need to know information about how to use the Cal-
endar application.

Scrolling Arrows

Use the scrolling arrows in the Calendar application as explained in “Getting Started.”

Icon Bar ~

Select this funcdon if you want to access the Icon Bar utilities. See Chapter 4 in “Get-
ting Started” for detailed information on the Icon Bar.

90 Reference
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Chapter 13

Editor

Use the Text application as you would a typewriter and filing cabinet. Anvthing n’mg7

nable that you would ordmmmv jot down, type, or record, vou can now enter and save
viz DeskMate. Letters, memos, school reports, grocery lists, or even reminders to
vourself can now be neatly and safely tucked away in a file . . . immediately accessi-
bie. You can even send (or edit] any file you choose from the Text application to some-
one else through DeskiMate’s Telecom application.

Instructions

Choose the Text application from the Main Menu.

Text Area

; Bar at the top of the screen contains the functons you can use in the Text

ks
application. The blank space on the screen 1s like f paper In 2 ’pﬂ—

& ™
< P [
vTiter and displays as manv as 22 lines of text. You can begin entering text nght awa;
Just type as vou would on a typewriter.
Reference 91
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Backspaces, erasing the character over which you backspace.

Switches between upperiowercase.

N Switches between overstrike and insert.
|
Text Editor
]
i
% ! T :
| | |
| ‘ 1 i
I8 N H
. , . .
E File Menu Esiock Meny | Find Menu ‘ Help Scrolling tcon
L : ATTOWS Bar
|
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File Menu

Use the File Menu for opening, closing, saving, merging, or printing text files or for
seeing a help screen that explains the File Menu. Select the File Menu by using the
mouse/joystick techniques or the keyboard.

Loads a file from disk, overwriting any document shown on the
screen. Select a file from 2 menu of existing files that appears on the
screen:

The Folder ] files appear by default. Select either Folder 1 or 2 to see
files in the folders. If more files ' n

screen, use (4 to scroll the name
want. Then, press [ENIER ) or click to select the file.

Exits the Text application and returns to DeskMate's Main Menu. You
can choose to save or discard any edited text.
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Text Editor

Saves the contents of the text area or a block of text without leaving
the tsx application. You can update the same disk file or specifv
another file name.

Inserts a document from the current disk "mto the document on the
screen. You can select the document to merge from a menu of existing
documents, and it will be inserted in the open document at the cur-
rent text cursor position. You can alsc use (ALT) (1] to merge.

Prints *be entire document or a “block” select. (In a "block” select,
only the selected block of text is printed.) You can also print by using
Talr) f_z"

.

Displavs a “help” window designed to assist you with text file
functions. ‘

Block Menu

Use the Block Menu when you want to copy, insert, delete, or select text. Because the
/rH';DC‘,,u
(See ""File Menu” if you want to print a selected block of text.)

2]

(2]
o

et

ctions all work with “selected” text, the select function is discussed first,

Keyboard: Positor the ‘u’ghﬁght at the bﬂgi:ming of the text you want
to select, and press [AL1) (6], or use the Menu Bar (press [ALT) (1)),
Choose the Biock Menu, and then the “select” opfon. The Block
Menu disappea:s, and you can move the curscr to select a block of
text. (Moving up or down selects entire lines as they are passed.) The

Py

highlight’s beginning and ending posmo s define the block.
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After vou choose a block of text, you can copy, delete, prirnt, or press
i to cancel the selecton

-

3 copy Copies selected text to a buffer. You can then insert the buffer con-
tents as many dmes in the text as you like by using the insert func-

tion. [ALT | (3] alsc copies text,

4 insert Inserts copied text into vour document. First position the highlight
where vou want the camec text to appear, and then select 1nsert
You can also use [AT (4] to insert text.

ext, If vou have'selected no text, this function deletes

te
the character ur xﬂ'er the cursor. You can also use (A7 (3] to delete.

ey
(3]
iw
e
4
e
)]
Y
i)
e
[0
n
]
m
HE
i
8]
o
n
(o9

provides specific instuctons for the

<3

T
%

e

r

Find Menu

Use the Find Menu to search for a word or phrase in vour document or to replace a

3

word cr DufabP with another.

Tofind Finds the first occurrence of a “'string”” of characters following the cur-
sor location. When you select find, enter a line of text, apd press
TENTER | Enter the text ex:ct’i warnt it to be found. For instance,

’

ou ;
to And “on,” you would first type a space, then on, followed by

\D
(9 1]
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& change Lets you

13/ Text Editor

7

another space. Typing nothing but ¢ and n could find “font,” “‘sonar,”

and so on. The cursor moves to the first occurrence, Chaose find

ag"‘n to find the next occurrence. You can also type a new search
string or edit the old one. [ALT ‘5 @ also activates fnd.

speciA; a se urch string (as in f1nd), followed by anocther
siring to be substituted. After finding the first occurrence, the corre-
sponding page appears, and the screen asks whether you want to
make the ﬁubsb“uncm You can press [ENTER | to find the next occur-
rence of the same string. This process repeats until vou reach the end
of the file. Next, the first page of your document appears. [ALT) (8]

also activates find.

7 nelp Displays a window designed to assist vou with Find Menu functions.

4

Help Window

Choose the help window when you need to know specific information on how to use
the Text application.

Scrolling Arrows

Use the scrolling arrows in the Text application as explained in “Getting Started.”

Icon Bar

Choosing this option displays the Icon Bar utilities. See “Icon Bar” in Getting Started

for detalled information on the lcon Bar.

9 Reference
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Chapter 14

The Index Cards ";;"‘4 ah’cn lets vou easily store and quuuf retﬂeve mfcmaﬁon You
can set up z customized i i

on a card in any forma* you wish. \: ou
anv card in vour file by setting up crite

an also O’f cards in a vanetv of orders or find
e card must meet to be found.

‘1(‘»
?r

as5iC screens: the main screen (* first screen vou see when
¥ in Menu) ;m format scr e*x (for setting up the
format of your ¢z { ards to the file), and the view

c
screen (for viewing and manipulating cards in the file). Each sceen and its uses are
discussed in separate se

The Index Cards menu bars and menus are organized as follows

Index Cards

|
3
|

|

t

H F ;
Main Screen } IFormat Screen |Insen Screen s
L ! J
! ‘ i ;
i i f
! ! | ‘
| . | | 1
! by iy T e ; = i ] i !
| (Fite| 'Card; |Heip] %acro%img :t’;"ﬁf Format | Help | Hnseﬂg | Help |
Meny Menu —— [Arows | | Ber . [Menu| ——— IMenu! ———

i : i

| !
% View Screen |
|

1

!
i |
i ;‘ !
t

H i H
? | f
H |

| iFile | |Card, [Help! Berolling:
‘
i

Wenu  Menu, " | Arrows |
, ‘
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14 / Index Cards

The Main Screen

—

When you select Index Cards from the Main Menu, you see:

Menu Bar

/Fi!e name window

index Cards
/

The main screen resembles a file cabinet drawer filled with blank cards. After you
enter a filename in the provided window, set up a format for vour index cards, and
enter information on those cards, each card on this screen is labeled with its most
irmportant infermaton. You dedde the informaton that will appear on the label as you
use Index Cards. : : :

The Main Screen’s File Menu

If you choose F i le from the main screen’s Menu Bar, you see:
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Index Cards / 14

Use the main s

creen’s File Menu after you have defined a format and added data to

vour card file. This menu enables vou to dose the file and return to DeskMate’s Main
Menu, print the entre file of cards (or only cards you have ‘marked”’—see the expla-
nation Lf the main sceen’s Card Menuj, or see a help window that assists you in
using the File Menu.

{ you choose

The view option is explained in its own section, later in this

.

Saves the file in its current state and retumns to DeskMate’'s Main
Menu.,

Prints marked cards, or if there are no marked cards, prints the entire
card file, with each card’s data. (See the explanation of marking cards
irn “The Main Screen’s Card Menu” and the explanation of marking
fields for Urin**?ﬁg in “The Find Screer.”)
i¢ print the file,

3

j You can also press [ALT] (2]

Displays a help window designed to assist you in using the File Menu

The Main Screen’s Card Menu

=rd from the main screen’s Menu Bar, you see:

apte* Generally,

o1
selecting the view option displavs another screen that lets you manipulate the cards
i vour file and the information on those cards.

pten, like view, is explained in another section of this chapter. It ena-

bles vou to add cards to your file.

Choosing the
look or change

rmat option enables you to set up the way you want your cards to
a card format already set up. This option is explained in its own sec-

tion, later in the chapter.

ﬁf’”""’ 2yice
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14 | Index Cards

Other Card Menu options are:

E delete

& mark

? help

Removes all marked cards or the currently hughlighted card (if no
cards are marked) from the file. (See the explanation of the next
option, mark, to find out about marking cards.) You can also press
(AT1[E] to delete cards.

Lets you select 1 or more cards to print or delete. First, highlight the

4

desired card on the main screen, and then mark it by choosing this
option. Then, use either the print function from the File Menu or
the delete funcHon from the Card Menu. You can also mark cards

by pressing (AT (6]
Displays a help window designed to assist you with the Card Menu
options. '

The Format Screen

Index Cards is set up so that when you create a new file, you move automatically to
the format screen, as if you had chosen Card from the main screen’s Menu Bar and
then chosen the Card Menu's format option. However, you can, once a file contain-
ing actual information exists, access the format screen by making the appropriate
menu selections. You can set up a format, insert and delete fields from the format, or

change the order in which you want to sort cards.

100
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Before you enter information on yows file's cards, you mus! set up a format, a way you

3
wani the cc:rc. 1o lock. The format screen enables vou to define areas called fieids. A
field contains a umnit of information that vou want to include on vour card (such as
name or ac‘:dress)‘ Each held consists of 2 parts: a label de scnbmg the information
d ering the information. You can set up as

11 , R
vou i enter, and z

The left column of the screen is reserved for ﬁmer‘mz field labels. A izbel alwavs
margin of the screen. Type 2 maximum of 12 characters on 1 line to

i abel. When vou ;‘?‘ssc (ENTER ] to finish 're label, any unused izbel are
Alis with dets and a colon, ‘and vou move to the data area on the same line.

You can reserve more than 1 lime for entering data. The data area on the same line as
the label contains room for 18 characters. Each additional line contains space for 3¢
v T e aach oy 1
craracters. 1f vou want addidonal Unes i the data area, press ¢ | for each extra line
- s 1r
Rererernge 1G]
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e held 1s as long as vou need. The cursor auto-
¢ next line so that vou can enter ancther jabel.

You can leave the data area totally blark so that when you enter information later, you
can enter it in anyv manner vou like. You ca“, on the other hand, further define the
lata area by using edit characters. Edit characters show that a certain type of entry is
required. For ﬁﬁxa_“ple

[a

,\
!

Phone number:
Date: Y Y

The edit characters in the example above are (, ), -, and /. After vou enter the ﬁeld
labels and reserve the data area, move to the line on whict you want to insert edit
c'm racters, and press | SHIFT '_——‘ to move to the data area, TvDe the apDroanatp char—
cter(s). You can erase unwz :e* edit characters by pressing (A7) (-] to backspace
ver the character vou want to dele

Oﬁ’

When vou later enter informaton in a data area containing edit characters, the cursor
skips over all edit characters so that you cannot type over them. In the previcus phone
number exampie, the cursor would skip the opening parenthesis and immediately
move to the first dot so that vou could type the number’s arza code.

Once you establish
B‘a ‘ The Menu Bar on
2 help screen that expl

The Format Screen’s Format Menu

When you choose Formal from the format screen’s Menu Bar, vou see:

[N
F‘f\:
?§
A
o



e

3

A

£

k! E celete
j f:ela

sori order

e

L

rond

Index Cards / 14

Deletes the enare field (label and data area) at the current highlight
position. st;hlzg‘\:/the field vou want to delete, and then select this
option. The field disappears, and all fields below 1t move up the num-
ber of lines the deleted field occupied. You can also use [ALT] (5] to
delete a field.

Changes the order in which your cards are displaved on the main
screen or on the view screen. DeskMate sorts cards by looking at the
inform maﬁo'w in the first field on a card or by looking at the information
in 2 field for which vou set the primary priority. Index Cards sorts
mctlv alphabetically. In the case of numbers, the same is true. If your

rst field contained 1008, its card would sort and appear before a card
"OI‘*"&JU_HO 9 in its first ﬁe,u, because the “1” in 1000 occurs “alphabet-
ically” before g

H\(J’

Suppose that vou arranged redpes in a card file by name and type
(veal cordon bleu—entree, cherries jubilee—dessert, etc.). The recipes
would be arranged in alphabetical order by the first field (name). To
see the recipes arranged according to type, you would change the sort
order to make “type’” the #1 priority field

change the sort order from Index Card’s default method of first
field, second feld, third field, etc., select sort order from the For-

t Menu. The current sort order .appears. The cursor moves only up
and down through the assigned priority numbers. Next, type a num-
ber, 1-5, to assign a sorting priority to any field vou like. (1 is the
highest priority, 5 the lowest.) All remaining numbers shift to allow
for the new priority ass gnment For instance, assigning 1 to a field
when anot ne* field already has first prioritv changes the other field’s
priority to £, and 50 On. nnahy, press [ENTER |

» fields on the card or the fields to
-5 in sorting. Any remaining flelds
's are sorted.

Index Cards uses only the firs
which you've assigned prioritie

3

4 ex:t Stores the format vou set up on disk, and returns to the main screen.
. " onelp Displavs a help window to assist vou in using the Forma: Menu
?§ Q‘“‘L‘O"IQ
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314 / Index Cards

The Format Screen's Help Icon

enu Bar to see general information

acty

Choose the help icon from the format screen’s M

about using the screen.

Thie Insert Screen

a cn the inser

{7},
-
o]
]
ot}
Enadl
m
3
o]
s
D i
w
A
[
1
o3

After a format exists for vour cards, vou are reads
To see this screen, select Card from the main screen’s Menu Bar, Then, select the
Card Menu's irsert option, or press (AU (4. The screen shows the labels and the
data area vou set up on the format screen, and vou can begin entering information in
the fields. After vou enter the data for the last feld on the card, store the card’s infor-

1 Menu, After the card is added, another

T r
ontnue to add cards or use the Menu Bar's Insert

The Insert Screen’s Insert Menu .

hoose Insert from the insert screen’s Menu Bar, vou see:

4 add
ex:t Lets vou stop adding cards and return to the main screen of Index
C I vou e on the screen when vou select ex:t, that

#
ctually occurs. When vou return to the

ded sort according 10 the order vou sef
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Index Cards 1 14

? help Displays a help window to assist you in using the Insert Menu.

The Insert Screen’s Help Icon

Choose the help icon from the insert screen’s Menu Bar when you want to infor-
mation to help you insert (add) cards.

‘ TE mar .
The View Screen
‘.‘\”p v your file containe cards, vou can use the view screen to see any of those cards
or change information on them. To see the view screen, move the mgn\gh* to any

on the main screen. Next, select Card from the main screen’s Menu Bar. Ther,
select view from the Card Menu. The screen displays the contents of the card you
“ghlig‘nted You can view other cards or change the information on the displaved
ard. After you change information and display another card, the changed information
be»omes part of the card you edited. Use the scrolling arrows on the Menu Bar
(explained in “Other View Screen Features') or the [SHIFT) (=) and [Sair) (<] to dis-
pley subsequent or previous cards. Anytime a card is on the screen, you can initiate a
search for cards meeting certain criteria, delete the displaved card, or print its con-
tents. These options are avalable to you through the view screen’s Menu Bar.

The View Screen’s File Menu

When vou select File from the view screen’s Menu Bar, a window on the screen

shows:
2xit
Reference 105
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zb.e Find Option. When vou choose opuon from the view scaeen’s File
Menu, a new screen appears, showing a orm in which you can enter criteria by
wrich you want Index Cards to search, For instance, if vou were looking for cards for

all people with the 1ast name of Jones, you could type Jones at a Last Name field.

You can use 2 special characters in the criteria vou type: 7 and ®. 7 tells Index Cards
‘ ’ ' t poesition is. Typing, for example, TANK
¢ Index Cards match SANK, BANK, or TANK, but not FRANK.

=4
o
put

ds that the character at that positdon and all subsequent characters
'ping A" in a field would let Index Cards match any word that begins
Typing *ANK would let Index Cards match any word at all in the field,
ause the first character is ¢, meaning that any number of characters of any type

+ can also Spe:;i that you want 1o search for a certain string of characters. Typing
*ARK* in a field would et Index Cards match DARKHNE ‘2, SHh KS,. or ARK itself.

Note that the first * vou type in specifying a stnng must appezar in the field’s first
character position.

The criteria you enter is only the basis for the information you want to find. Using the
lones example, vou could find all persons with last names occurring alphabetically
‘:ef }cmes, after Jones, or even equal to {the same as) Jones. When you decide to
fo m\,—mancw less than, greater than, or equal to your search cTiteria, you are
smg a relational operater. an operator (<, >, or =) <pecm"u‘g a relationship between
=e information vou type and the information you want to find.
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Selecting the Fand option on the find screen’'s menu bar lets you further

search "TIW“"G you erwer and performm other functions. When you choose

Lois

the find screen’s Menu Bar, the screen shows:

specify the

-
I

!

ind from

You can chocse any of the first 3 optons (the relational operator:) whether you have
T

already typed your search criteria ©
after you choose those options.

-

The Find Menu's optons are:

not. Type vour search criteria either before or

' less Specifies that you want to search for information less than the search
criteria you enter in the carrently highlighted field. You can also press

[elT @to select less.

2 grester Speafies that vou want to search for information greater
search criteria you enter in the currently highlighted 3

also press (AL 1[2] to select greater.

11}
"
£
[
i
.

criteria you enter in the c.z*rcrz}* Highlighted ra‘d

than the
You can

Specifies that you want to search for information egual to the search
If vou do not

choose less, greater, or equal ndex Cards assumes that you want o

use equal.) ‘zou can also use (AT (3) to select equal.

7 find Activates the search through vour fle for anv cards matching the
search criteria (and relational operator, if vou specified one). The Find
Menu disappears, rzd the first card containing a field in which infor-
PF
ea

mation matches vour criteria app
(ﬁx'pi;med O;.u nF

(=] to see either the next or previous matching card. Inde
finues 1o display matching card

" 1

activates fi:ng.

ex
ds until yvou choose the ¢!
on the Find \ie“u or return to the main screen. Pressing

VALY ]

rs. Use the scrolling arrows
gatures’’) or [§rFT | (=) and [SHIFT)
Cards con-
emr op‘fmﬁ

(7)) also

Reference
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14 ! Index Cards

g msrk oggles betrween marking (or unmarking) fizlds vou want to print as
cards are printed. Marked fields, which will print, appear with aster-
isks in the label area. Highlight the field you want to me tk, and

select this option. Index Cards marks all fields by default so that
all the data on a card will print unless vou specify omem ise. To print
the card’s information. see “The View Screen’s Card Menu.” You can
|51 to mark or unmark felds.

s vour search insiructions before the search begins, and retums
to the display of the card previously on the screen.

7 help Displays a window to assist you in using the Find Menu options.

The find screen also con**inc a ‘“elp icon on its Menu Bar. Select this icon to see gen-

The View Screen’s Card Menu

Choose Card from the view screen’s Menu Bar to delete or print the displayed card’s
information. A menu window appears:

(22}
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Index Cards / 14

Prints the currently cuplaved card. All fields on the card print unless
vou unmark {(via the find screen’s Find Menu) certain fields. You can
also press [ALT] (2] to print a card. If you are currently searching, this

M

function prints the currently displayed (matching) card and all subse-
guently matching cards.

Displavs a help window to assist you in using the Card Menu options.

Other View Screen Features

The view screen
arrows. Select

=

‘s Menu Bar contains 3 other features: a help icon and 2 scrolling
the help 1con to see informaton that assists vou in using the view

screen. The 2 scrolling arrows, available onlyv if you are using a meuse/joystick, enabie
vou to display the next or previous cards in your file.
e
109
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ation as a blank canvas, and
4ng vour own patte‘-\s or choc
&3

ou mmight think of the Paint applica
can draw and edit on the screen, crea
terns alreadv avail abie using a nur*‘b
256x192 with 2 colors or 128x152 with 4 colors. (There are 3
choose from In the lower resolu WN) A label line at the top of ¢
functhons that you can use throughout the Paint program. \Thgee
specific to Paint, and the other 3 zre standard DeskMate functio
the screen is for you to use in drawing,

©

Instructions

Celect Paint from the Main Menu.

r of axauable ‘tools.” C'noose ar

the scr

vou, the artist. You

of the functons are

ons.) The remainder of

o5

Fars
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Practice drawing on the screen for awhile, using the methods described next for the

kevboard or the mouse/jovstck.

14

g

Edit Help | lcon

1]
Do
I

Menu l L—-————J Bar

Faliette Too!

Menu

File

Menu Menu

S

Keyboard Techniques

Paint works best with a mouse or joystick, but you can also use the keyboard.

Use the arrow kevs to move the pend! on the screen. (See “Getting Started” for meth
ods of moving the cursor more quickly.) Pressing the space bar once “lifts” the pendl
from the canvas, and pressing it a second time lets vou draw again. If you are using
the keyboard with Paint, practice awhile to become more profident.
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Loaﬁ:« a file fFom disk, replacing any drawing on the screen. Select a

e you want to open from a menu of exisiing fles on the disk.
Exits the Paint application and returns to the Mamn Menu. You can sav
or discard the drawing on the screen.

Saves the p ;Ji:*: on the screen without closing tne Paint application.
You can update the same disk file or specify another filename.

Prints the screen in black and white or coler. After vou choose print
from the File Menu, you can select the method with which vou want

to print.

2
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Paint / 15

You can print a black and white screen in small with any Radio Shack
printer that can be used with vour Tandy Coler Computer. Check ycur
printer manual to see if vour printer is capable of printing a medium
(condensed mode) or large (compressed mode) black and white screen.

You must have an ink jet printer to print in color.

, ey g .
You can also use {AL1 |2 to print.

7 help Displavs a “help” window designed to assist you with Fie Men
functions.

Palette Menu

Use the Palette Menu to select a color or pattern to be used in creating your master-
piece. The palette has either 2 or 4 solid colors (depending on the resolution you are
using) from which to choose. In the 2-color mode, 2 of the colors appear as shades of
the foreground color. There are also 16 fixed patterns, 1 of which you can edit (the
bottom right pattern).

Move the highlight to the Menu Bar, and select Palette,

ttern. The Palette Menu disappears. You can use the patterns you choose
ocls: pencil, brush, line, square, circle, spray, magnify, and fill. See the

113
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Eraser

The cursor is in the shape of a pendl, and you can perform
freehand drawing using a single point in the current color.

Uses the selected color and brush shape, and, like the pen-
al, lets you draw freehand on the screen.

The shape of the current brush defines the cursor. Choose
the brush shape from the Edit Menu's -rusn option.

oy

pry

o
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Pamnt / 15

This tool draws a line between 2 points. After you select the
4 first point, 2ll possibilities are shown untdl you select the
second point.

Box Draws a box by using 2 selected corner points. All possibili-
ties are shown until you select the second point.

Draws a circle or oval by using a center you selected and
then an x-y radius. All possibilities are shown until you
choose the second peint.

This tooi “spray paints’ with randomly scattered dots. This
freehand painting is like drawing with a can of spray paint.
The Sprav option uses the current color and brush shape.

7

Magnifies a section of the screen that you select. You can
draw on the magnified screen using the current pattern and
brush shape to put the smallest details in your picture, then
retumn fo the normal size to see the results.

You cannot “undo” the last item drawn on a magnified
screen.

pod
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Select

Fills an outined area with the current pattern or color.

Lets you add proportionally spaced text to the graphics dis-

piay using the keyboard.

Select an area on the screen by surrounding it with a dotted
square. The options are:

erzse

copy & paste

i
"

e
&)

Erases the selected area, using the
current background color.

Places the selected area’s image into
a buffer and then erases it from the
screen.

Places the selected area’s image into
a buffer without erasing it from the
screen.

Places the image in the buffer at the
desired position on the screen.

Note: The buffered image remains
intact even afler ancther picture file
is lcaded from a disk, enabling you
to copy wmages from one picture (o

ot

s

(=23
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If you choose Paste, there are two
options available, tran
and sol1d.

-

rersparent lets vou place the
buffered image on the screen by
overiaving only the image and not

its backgrc;nd.

Sclid places the entire selected
area on the screen, erasing every-
thing under it.

Edit Menu

The 6 functions on the Edit Menu let you erase, edit, and change the graphics screen
mode and color set.

(o8
[}
(e}

(9]
bt
m
L]

Selects a brush sbape A window of brush shapes appears. Select the
type of brush with which vou want to paint. You return to vour can-
vas. The following too!s can use the brush shape you select: brush,
line, square, circle, spray, and magnify.

Erases the lzst thing drawn on the scre

A
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Feliern

This function lets vou define and edit your own n pattern {16 x 8 in high
resolution, 8 x 8 in low resclution). The pattern is located in the lower
right corner of the Palette Menu. When you choose Fattern, the
screen shows:

s
s
[p]

on

1. Kevboard: Press [ALT |

| =) and then use the arrow keys to move to
the color vou want.

Mouse/Joystick: Point to the color you want to use.

2. Keyboard: Press [ALT] (=) to return to the pattern, and then use
the arrow keys to mowve the highlight to the square you want to
change. Press the spacebar. The square changes to the color you

chose. '

Mouse/Joystick: Point to the sqx vou want change and click.
The square changes to the color chose.

3. ConiHnue changing the squares in the pattern until it locks the way
you want it.

click) to record the

st
u
2
5%

4. Press [ENTER] (or point to [ENTCR

LY [

and click) to cancel the

"

“alette Menu from the Menu Bar to see the pattern
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If you use this option with one of the high resclution background
colors (green and black or buff and black), there are two colors from
which you can choose and the size of the squares are smaller.

Device Selects the device with which you want to use Paint:
keybosrdonly
joystlick
mousze or JOYEBELLICK

Select the device you want.

Cotor Lets vou change the graphics screen mode and color set. Note that if
you change resolutions, the contents of your copy buffer is lost
Screen Colors
green-black 258 x 192
buff-black 258 x 1982
puff-tblack 128 x 182
green-yellow-bluye-red
buff-cyan-magenle-orange
7 help Displays a help window designed to assist vou with the Edit functions.

N

Help Window

This Menu Bar selection displavs a help window designed to assist you with the Paint
functions.

Choosing this opton displavs the lcon Bar utilifies. See “lcon Bar” in “Gettnng

Reference 119



}

e

Ledger

With the Ledger application, vour screen becomes a spreadsheet divided into rows
and columns. After vou enter data and formulas, Ledger calculates the values for your
formulas and displavs the computed values automatically. You can tvpe any text you

!
wish, such as titles and headings, to give your reports a professional look., You can

readsheet as a Ledger (or as a Text file to include in a document) after cus-
to meet your specific needs.

ne keyboard and mousefjoysock techniques for Ledger are the same as described in
“Getung Started.”” Any variations are explained in this chaprer.

b

Instructions

i
i
1
3
i
b3
1
1]
Cell 1D —__ &
190 Reference
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The vaeadcheet cOnsists of e 90 columne and 99 rows in
which vou can enter data in the Ledger applcation. > area at which a column and a

’\f‘\i-' $
Columns anda

row meet is called a cell. You will enter da cells.
There are 3 types of data you can enter:
number consists of the digits -9, an optional decimal point, and an
optional sign {(+ or —)
label consists of alphanumeric characters but begins with an alpha-

betic character A-Z

formulas for formulas to be used in calculations
The contents of the cwrently marked cell (number, label, formula, or empt ty cell) are
identified at the bottom of the screen fcell 1D, If the current cell contains a formula,

r

the first 25 characters of the formula appear.

=

To add data to the ledger, position the highlight on the desired cell, and type the data.
When you move the highlight, the data that you entered remains in that cell. After
vou enter a mmber, it appears flush right in the cell (right-justified). Labels align to
the left inside 2 cell (left-justified).

Although the built-in column width is 7, you can enter u to 28 characters for a label
ard up to 18 digits (plus a deamal point i anu rrber (14 digits
before the decimal point and 4 digits after). If yvou &y DE’ more than 7 characiers in a
cell, the cells on the right of the current column shift b H* 1 character for each additional
character you tvped. Press [ENTER | to increase the curent column width. All columns
to the nght are positoned accordingly.

"Q

In addidon to automaticallv widening a column to accommodate long cell entries,
Ledger reformats numbers in the same column when you enter a number with a larger
decmnal forﬂa* There are 2 reasons to reformat numbers 5o that thev have the same
number of decimal places and so that the greatest number of dedmal places be used:
7‘ for maximum precision during caleulation, and ) for cosmetic purposes 5o that all
numbers in the same column are zligned with the decunal point in the same position,
rs vou previously entered in 2 column contained only 2 dedmal
number with the maximum of 4 dedmal places, zero
i to the earler eniries. However, if appending addi
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ma! places to another number (other than the one currently being entered) increases

the column width, you see s+ s+ +»+ e instcad of the number with the extra zeroes. To

Pildi,

display the entire number, increase the column width so that the new number with

=

. PO ¢ (S ~
ore decimal places can At

Foliow the instructions below to change the column width:
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v,

(§1)

gl

et

Yoty

3

Move the highlight to the col

=]
5

‘]
5

Keybeard: Press [SHi7T) (1] to reach the column margin,

Yo’

o

Mouse/Joystick: Foint to (3 on the Menu Bar and click twice.

Keyboard: Use the [~ and (-] keys to move the highlight.

Mouse/Joystick: Point to CJ or [ and dlick to move the highlight.

Select format from the Block Menu. The following prompt appears: .

lumn width 87
L] &
T all c n

prm———
81 {Th

Enter the setting and press £ e margins can be set from 3 to 28))

et

Move the check to the option vou want (“this” or “all columns’) and press [ENTER

or click.

The columns are adjusted automatically.

operafion vou are in and retwms

{ Eiig Many | IBiock Men, Seroliing Arrows. lcon Ba
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Ledger / 16

close

save

Loads and displavs a s;rea:’»s‘“eet file. The fle you open replaces the

file in memory. Select the desired file from a menu of existing files
Note: To store the information on the screen, =zave the file before

Closes the current file and returns to the DeskMate Main Menu. You

are given the option cf saving or fiiccard‘mg the current spreadsheet. If

vou answer ves, enter a ﬁ)e“_‘mé if this is a new file or if you want an

eted copy of an exisang file as well as the C!l:’l‘,’“m.l file. Press
A

TER | alone or click to save t‘he spreadsheet under its existing

If vou use close to save a spreadsheet, the spreadsheet is stored as a
Ledger file. To save a spreadsheet as 2 text file, see save, below.

You can alsoc press | (BREAX | at any time on the spreadsheet screzen
Pressing (BAEAX | works in the same way as choosing close.

adsheet {all 9% rows and columns) as a ledger

Saves all the current sprea
d portion of the spreadsheet as either a spread-

: selected
e, -

y

1%
0
=3
P
)
<
I3
w
m

o
el
A
e+
.

To save an entire spreadsheet as 2 ledger file, choose the save function
after entering the ledger data. Enter a filename or press [ENTER | alone
to resave a s*:readsho:—e:
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sreadsheet to use in a text fle

You may want to save only part of a sp
to merge | t e "'an To save a partial spreadsheet as
either a t define the portion of the spread-

sheet you wish tQ save by using the select function on the Block
Menu, then use this function. (For exampie, you can first define the
block by highlighting all cells vou want to save.)

When you cheoose szve, vou have the option of saving the partial
spreadsheet as a dommsnt or spreadsheet file. Choose the file format,
vou want, and then enter a filename or press [ENTER to save the
spreadsheet under its cld filename.

t merge Merges a partial spreadsheet file into the current file at the current
highlight position. Select the desired file from a menu of files that

o & : ’
appears. You can also use (AL (1] to merge. All formula cells being
merged are relocated and adjusted to correctly reflect the row or col»
umn rearrangement.

Note: A comple te spreadsheet cannot be merged into another spread-

sheet fil
2 print Prints the entire file or a seiected block of the current spreadsheet. Be
sure that the pnnter settings are correctly adjusted before you print.
You can also use [ALT] (2] to print
To print part of 2 spreadsheet, first define the portion of the spread-
sheet you wish to print by using the =zelect function on the Block
Menu, and then use this funchon.
; To print the entire spreadsheet, select the print function. Al columns
and rows, which contain data, are pnnted. Blanks are printed for the
: empty cells between data cells.
7 melps Displays a help window to assist you with the File Menu.
124 Reference
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Block Menu

After Vou

(53]
L]
1]
i
[£]

e

o
niv the currently highlighted cell. To use a function on a
‘q.b

single cell, first positon the ‘ug‘\"g, it on the desired cell, then selec

*”’we functon. To use & function on a block of cells, move the highlight
o the first cell vou want in the block, and then choose select. Move

the highlight to the last cell of the block, and then choose the desired

function. Y. Is¢ (AT (€] to select

u n. You can also use (AT ] 18] to select.

All Block functons work on a selected block of cells or, if vou select
} sl

To select with the keyboard:

d
S
et

lace the highlight at the beginning of the block you want to

Choose s=lect from the Block Menu or press (A7) (5]

28]

(52

Use the arrow kevs to widen the highlight area until you include
all desired cells.

4. Choose the desired funcion from the Block Menu or press the
desired (AL | code.

1. Point to the beginning of the desired block of cells, and click and

Reference
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After vou define a block of celle bv selecting it, vou can use one of the following func-
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3

Changes the format of a selected block or the current cell (or the width
of the current column or all colurnns if the highlight is in the column

MArgin)

To change the width of a column or al
the colurmn margin. Posiion the high
umn you want to change, and then sel
change the displayed width value, type the new value, a"nd press
[ENTER | Type 6 before a width value less than 10

columns, move the Higfnlight to
ight on the num ber of the col-

(For example, 1) (AT (7 on Row 1 2) format)

Column widihs 3-28
-
Change column widih:
=4
Next, you are given the option of changing the current CO‘L‘J“I\ only or

all columns. Press LENTER | or dick to change the width of the current
column only. To change the width of all columns, press (=) and
(ENiZR, Or point o Al an ng click.

To change the format of a single cell: Position the highlight on the
desired cell, and then select the format functon. You can change the
justficadon of a label cell, or both the justficanon and number of ded-
mal places of a number cell.

Reference
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RS

Justify 1<) [
Fraclion g 1 z 3 4
Press [SPACEL] to choose
Press [ENTER] 1o continue

(You would see only the Just1fy option if the cell contained a label.)
For the Justfv option, you have 3 options: to lefi- or right-justify the
contents of a cell, or to keep the current justification. For the numeric
fcrmat option, you have é options: & (whole number or integer forma*;,

1 (1 digit after the decimal point}, 2 (doligr and cents fon’nat\ 3 (3 dec-
imal piaces), 4 (4 decimal places), or ‘A‘.F:\:p‘ g the current numeric
format.

Press the space bar to move the highlight to other format choices. If

ess the space bar when the rightmost option is highlighted, the
ht temnporarily disappears to m.d;cate to keep the current format
(leave the contents o f the c:eL as is).

Press {4 ] and :j or move the meusefoystick to move the highlight
Hemeew the 2 format options. When vou are finished and have
changed the Aa"‘m tin the desired manner, pre<5 ENTER ] to record *‘ne
changes. If you've chan 3 nt to keep the previcu

cell forrnaz pres *’“TEA‘A“.% to cance 1 the chanoes In either case, you

l.ll

To change the format of a selected block: First define the block using
the seleact function, and then choose the forma! function. Then,
follow the instuctions above for changing the format of a single cell.

Places the contents of a selected block or the current cell in the copy

¥

buffer. After copving the desired data, use the .rsert function to
place the contents of the copy buffer in another arez on the
spreadsheet.
If vou need more space in vour file, you can copy an empty cell into
the copy buffer, overwrinng the contents of the buffer and aliowing for
more MEemory space.
You can also use (A7 210 copy.

b { q]ﬂc-
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If 2 row or column in which vou are msertmg data already contains

' revious data is lost and overwritten by the new data. If you

e creating a blank row or column, the data and fomwa originally in

that row or column (and all subsequent rows or columns) shift down

or to the right 1 row. Row and column numbers in formulas also

“shift”” so that the same values are used in calculations. Al formulas
ctiv

are adjusted o ¢ reflect the row or column insertion.

»C&uu

If, while vou are inserting a row or column, z formula does not refer
to any valid ¢ 'n the spreadsheet, the cell I.D. line displays

Invalac f erm;ia. For example, suppose that in cell R2C1 you
entered the formula, R99+1. You then moved the marker up one cell,
then to the row margin and inserted (using (A1) (4]) a new row. Your
formula would move to R3C1, but it would become 1nvalid, as it would
then read R 188+ 1.

Erases the o*f'en (labels, numbers, and formulas) of a selected block
or the current cell, You can also use [ALT (5] to deiete. To erase data in
an entire column or row, move the kﬁc*ﬂzg"ﬁ* to the desired column or
row number in the margin area, and then select the de letle function.
A1l formulas are adjusted to correctly reflect the row or column
deletion.

Enables vou to enter a formula for the current cell or selected block.

,__._.\__..

You can also use (A7 119 to enter a formula.

ghlight on the cell

e hi

displaved, select the
d p ess {ENTER |, (You
way.}

To enter a formula for a single cell, pcmtm th
alculated vzlue to be
the deszred ar"mﬂa

the cell bloek by
functdon, and then

-

28
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ormula{s) into anocther loca-
hat you copy is adjusted to

he new location.

vVithin a forrnula, mathernatical operations ar pm"ormef" from left to
righi. Parenthetical operas ;cms are performed fir .' . functions like SUM,
second, power third, multiplication and division fourth, and addition
and subtraction last. When parentheses are nested, the innermost

operations are performed first. The operations available for use in for-
mulas are in the following tables

Formula Operations

between 2 cells:

Addition * Multiplication
Subtraction / Dnvision
Power

for a row or column

‘&_mu"n value
Sum of the values

for a cell

Absolute value '

; T lnteger truncation
Following are examples of formulas using some of these operations.
AVGCT Adds all the values in the current row, beginning with
column 1, over to the current cell, skipping any non-
numeric data, and divides bv the number of numeric
cells added.
Reference 12
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MAX(C4) Displavs the maximum value of the current row, begin-
ning with colurmn 4, over to the current cell, skipping
any non-numeric data.

MIN(RI) Displavs the minimum value in the current celumn,
beginning with row 1, down to the current cell, skip-

SUM(RS) Displays the sum of the values in the current column,
beginning with row 5, down to the current cell, skip-
ping any non-numeric data.

ABS(RZ(C3) Multiplies the value of the cell in row 2, column 3 by -
1 i {and only if} it is a negative number (absolute
value).

&

INT(R4C2) Displays the integer value of cell R4C2.

R1C1+R3C4 Adds the value of cell R1C1 to the value of cell R3C
and displays the result.
.

Two special characters can also be used in a formula: a questHon mark
{?) indicates a constant value that vou need to enter at the time of cal-
culation. For example, if a cell formula is entered as 74, then when the
calewdation function is selected, you'll be prompted to enter a value for
A 50 that computations can be completed.

A number sign (#) indicates a cell in a formula that is not adjusted for
each successive row Of column, but rernains constant.

Displays a window designed to assist you with the Block Menu.

o

«
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7 find Finds a particular cell label. You can also find a formula.
A window appears with the prompt:

FIinD

Enter the number of the cell (in R#C# format) or the string of charac-
ters you wish 1o find. The window containing that cell is displayed
with the entry marker on the spedﬁed cel. To find the next occur-
rence of the same search stnng, reselect the find funcdon, and then
press |ENTER | or click the mouse/jovstck bution,

You can also use (ALT (7] to find.

Calculates and displays the results in the cells in which formulas were
caleulate entered. Data is cal leulated according to B contents, from left to right
and top to bottom. Any non-numeric data is skipped. If vou have
entered 2 formula that cannot calculate, the message, ¢*Errer
appears.

o

¥ an “overflow” {to

containing the formu

' - 0
a2
5
SRt
E)‘
]
24
w

You can also use {ALT | (8 to calculate.
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nelp Displays a help

Help Window

P
H

Scroiling Arrows

window designed to assist you with Cells Menu

Displays a window designed to assist vou with Ledger functions.

rolling arrows as explained in “Moving Around On the Screen” mn “Gettin




Chapter 17

Telecom

ecom application }ets vou convert your Color Computer imto a comununication
ice mlied a terminal. As a terminal, you can communicate with other computers by
nding and receiving mformatxon,

Tei
Q.
se

To use the Telecom application, vou need:
¢ Anocther computer with which to comurnunicate

i

+ Additicnal equipment for your Color Computer so you can connect it to another
computer

Telecom lets you communicate with any computer that has:
« A program for cornmunicating with small computers
+ Equipment for conneciing to small computers

The program the other computer needs can fall into either of these categories:

"3

« A “host" program—This kind of program lets a computer make its resources
avzaiiable to terminals. txam}} s of host programs are information services, host
operating systems, and simple host programs (such as the Host application for
the Tandy 1000 DeskMate program or a public bulletin board system).

3

The equip«.l ent the other computer needs depends on the kind of eczul,rr\&u you are

cu can connect vour computer to the other computer in 2 ways. Eam way
requires ﬁa; you purchase different kinds of communication ecuipment:

Reference 133
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» Over a telephone, using a small-computer modem ({such as the Tandy DC-

-

<
R5-237 Pak Y

Modem 1), the Color Computer | ak, and an R5-237 cable.

This connection requires the other computer to have a modem compatible with
the modem you are using.

or

[N

. s - L :
Note that vou must place the R5-232 Pak in Slot 1 of the Multipak Interface and
13

the disk controller Program Pa

Through & cable, using the Color Computer R5-232 Pak, an RS-232 cable, and a
Null Modem Adapter.

34
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Telecom | 17

This connection lets vou tramsmit information ai much thigher rates of speed
vou can use over the telephone. It requires the other computer to have a

standard R5-232 connection interface.

Be sure that all your equipment is turned off while you are making connections and
setting up. Then, when all the equipment is reacy to work, turm on the Multipak
{rterface before you turn on the Color Computer.

A Note to Customers Using the R5-232 Pak

The R5-232 is & standard thal vou can use to connect a computer to &8 modem o7 a
suter. This means that, in theory, vou shouid be able to use
the RS-132 Pak for connecting the Color Computer to modems and computers from
manufacturers other than Tandy.

in practice, however, the connection between a Tandy KS-232 and another manufactur-
er's R5-232 will sometimes not work properly without having a technician readjust
wires on the RS-232 cable. This is because manufacturers sometimes implement the
R5-232 standard in different ways. For technical information on how Tandy imple-
mengs the R5-232 standard, see the manual that comes with the R5-232 Pak.

An Overview of Telecom

Telecomn has 3 screens. They are:

¢« The 5tatus Saeen—This screen lets you set up Telecom for communicating with
angiher computer.
 The Termiral Screen—This screen lets vou connect to and communicate with the

P o
Other computer.

' things: 1) access the information

* The Memory Screen—This screen lets vou do 3
a file"with the other computer, or 3)

1 o b 1y Py Ea s
that has been communicated, 2) exchange

exif Telecom.

Reference 135
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Following is an example of how vou would use the Telecom screens in communicating

with a host computer.

3

host.

o3

1. Use the status screen

vou want, save or print this informatiorn.

to prepare for communicating with the host.

Use the terminal screen to connect to, logon, communicate, and logoff from the

Use the memoery screen to view the information that has been transmitted and, if

D

i
i

e
H
H

D

Com

Status Screen ;

Terminal Scresen

Memory Screen

N |GV

i
f
' |
l i
| | |
!
3
i

H 1 i 1 - ' . H ‘ ‘! 2
t UFue) View] (Help lcon user View. Help! lcon |
L Mend Mend  — Bar | iMenuy Menu . Bar
[ : : ) e

- o o
[ Filg | View! . Help!

Mend  |Menu
{ [N
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Instructions

At the Main Menu, select Telecom.

NMenu Bar

Status Settings

The menu bar contains the familiar Deskbiate icons as well as options for displaying 2

2nLs.

« The View Meru lets you move from sceen to screen and is available from all the
. :

Telecom screens. 1t is descrmibed below.
« The other menu (in this case, the Fie Menu) contains functions unique to the
screen you are using. It is described in the sec
screen.

ction dealing with the particular

Py
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View Menu

—

3

Select Teiecom’s View Menu, which is available from all the Telecom screens.

memory Displays Telecom's memory screen. Pressing (ALT) (5] also displays the

IMEIMOry screen.

ks
Terminel Displays Telecom'’s terminal screen. Pressing (A7 6] also displays the
terminal screen.
Statlus Displays Telecom's status screen. You can also use [ALT to display
the status screen.
Help Displays a window designed to assist you in using the View Meru.

The Status Screen

Before communicating with another computer, you need to tell Telecom how it should
transmit information to that computer. The status screen lets vou do this by adjusting
2 number of settings.

For vour convenience, the status screen also contains a File Menu. This menu lets you
store your status settings on diskette so that you won't need to set them each time
you comrmurnicate with another computer.

Reference
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Move to the status screen. You see the status setungs that Telecom is currently using.
¢

The first time you use Telecom, the screen looks like thi

t——S8tatus Settings

For most of the settings, Telecom offers a choice of settings and highlights the setting

it Is currently Lsmg To change a setting, simply select the new seting by positioning

the m;;hgg"\t and pressing | (ENTER | or dlicking.

For example, for the Line Feed setting, Telecom offers the choice of ON or OFF and,
with highlighting, indicates that this setting is currently UFF. Te change the setfing,

seiect OH,
vour converdence and
line, and type the infor-

The Use=r Key & and User Key © settings are purely for v
are described below. To enter these sertings, select the desired

te, if your user ID were /'43
pressing [ENTEAR | or clic )

mation, pressing | TENTER | when vou ﬁmsn. For exampl
lect User Key 8 f”h'y' moving to that line an

vou conld sels
and type 7H805 [EATIR | to presel your Lser jing

fn

The status setfings and th

ok
[OX}
R el
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If you are one of these customers, vou can enter anything that you usually have to
send to another terminal when vou log-on and use the status screen's File Menu t

@]

save this information with the rest of vour status setfings. Then, when you enter the
terminal screen and log on to the host, you will no longer need to physically type and

enter that information—iyou can have Telecom send it automabcally.

Serial Port-—Always check this setting before communicating with another com-

puter. It defines the communications driver used in Terminal mode. If vou are using
an RS-232 Pak. tvpe /T2 at this prompt. If vou have other drivers connected and know
their descripto } u can specify the appropriate descriptor at this prompt.

Caution: Do not type anvthing at the Serial Fort prompt if vou have no communi-
cations device connected to vour computer,

Baud rate—Always check this setting before communicating with another com-
puter. It tells Telecom how fast to transmit information to the other computer. The
higher the baud rate, the faster the tranismission.

« If using an external modem, you must choose a baud rate that your modem can
use. The other computer must also use this same baud rate.
¢ If using the R&-232 P

5

other computer also uses

2k connection, you can use any baud rate provided that the
'.“us ame baud rate.

.

top Bl tz—Always check these 3 setiings before com-

ey have a technical meaning that tells Telecom

1}
nformation it ransmits to and receives from the other computer.

5

e = om
word ileeg,

runicating with another computer. Th
e ic

how to code th

You can use any combination of these 3 settn
uses the same combination. Most computers use

&

B.kit word size 7-bit word size
no panty even parity
I stop bit 1 stop bit

P

e Rﬁ:i:ﬁ"m'ic-‘f
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Iso, although this is not a funcdon of the terminal screen or, for that matier, the
elecom application, you might find it necessary to physically disconnect your modem
from the telephone when you finish communicating with the other computer.

Connecting to the Other Computer

The way you need to connect to the other computer depends on the kind of commuri-
cation equipment you are using.

External Modem. If you have not already done so, connect your modem to your com-
pater and to a telephone. Then, follow the steps in your modem manual for connect-

ing to the other computer.

dem is an autodial modem, the steps cutlined in vour manual might involve

s

your mo
‘our sending commands to your modem.

.

R5-232 Cable. [f you have not already done so, connect the 2 computers Then, if the
cther computer has not yet entered its terminal mode, it shouid do so now. This i
that is required to make the connection.

&

Communicating with the Other Computer

You should now be able to communicate with the other computer as a terminal. As a
terminal, Telecom sends each character you type to the other computer and displays
each character it receives from the other computer.

For example, if You type the letter A", Telecomn sends an “A’” to the other computer.
If the other computer sends back the letter B, Telecom displays a “B” on your

it
sCreen.

If you are unable to communicate in this way, try pressing (CTRL] (T] and [ENTER | & few
times. Some host computers require that vou press these keys to get their attention.

computer service, the service might ask you a few

If you are communicating with 2
questions about the type of computer or terminal you are using. Following are some of
tne most common questions and the answers with which we suggest you respond.

i

2
'S
L2
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¢« What kind of terminal do vou have? Select TTY or Other. TTY stands for
“teletype,”’ a simple type of terminal requiring less technical protocol to
cormnmunicate.

¢ How many lines does your terminal have? Select 22.

¢« How many characters per line does your terminal have? Select 32

When considering the number of characters per line your terminal has, you also need
to consider the way your printer settings are defined. Be sure, if you are going to print
the text you transmit/receive, that the line length you specify to your printer matches

the number of characters per line on your computer. Othe‘wise, you might find it dif-

3

ficult to read some of the information you print due to “extra’” carriage returms.

The tasks that you can do while communicating with the other computer depend
entirely on the other computer:

« If you are communicating with a host computer, you can perform any number of
tasks depending on the resources of the host. For exampie, when communicating
with the Dow Jones Retrieval Service, you can analyze stock prices.

- If you are communicating with another “terminal,” vou are limited to one task-

changing informaton . You can exc hange * me«sag s that yvou and the pe:sm";

¢ the other terminal type, such as “CAN YOU READ ME?” and "YES, | READ
YOU.” Or, you can exchange files by using the memory screen’s File Merm

While communicating with the other co*xpmz vou might find it useful to send spe-
czl “control characters.” To send a conirol character, press [ {TRL | and, wnile boldgxg

down [ZIRL), press the next letter. Some control characters vou might want to send
are!

[CTaL) [§ b—to temporarly stop tansmission (sometimes called the “XOFF”

[LTRL @j to restart transmission {sometimes called the “XON" character)

(CTRL ] (4 j=to backspace

Pieage note that ,h above characters will work onlv if the other computer agrees on
their mearings. Some computers might interpret them in a different way.
144 Reference
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i the other computer sends vou a special character that Telecom does not recognize,
st s y it. Some special characters that Telecom

0D — carriage return

ix D for the other characters that Telecom recognizes.

Refer to Appendis

The Terminal Screen’s User Menu

Select the terminal screens’s User Menu This menu lets vou send preset information
{such as yowr user I.D. and passwordj to the other computer, provided that you
entered this information as part of vour status settings. You only need select the
option on the menu that vou want Telecom to send, and it is sent without vou typing

it in.

User #ey B Sends the information vou preset on the status screen for this key to
the other computer. You can also use (A7) (8} to send this

informaton.

o
ey
O
4

8 Sends the information you preset on the status scree this key to

the other computer. You can also use [(ALT] (8] to send this

[
information.
help Displays 2 window desigried to assist you in using the User Menu.
Reference 145
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Telecom stores all the information that you and the other computer transmit to each
ther in & temporary part of memory called the memory file. The memory screen lets

vou view the contents of this memory file,

een also contains a File Menu that lets the computer perform many
. For example, one function on the File Menu lets you make a perma-
he memory file. Another function lets vou send a file to another

wemory screen. You see a screen containing the current contents of the
You can scroll through the memory file in the same way that you can

memory fi
scrol throu

(;’J [1:)
ey
Rt
(W
[
L;Q‘
2
o
1]
2]
b
T
o
o
&

The storage area can hold a maximum of a }D*oximateiy 13,800 characters. This is
approximately 18 screens full of informaden or 5¢ screens that are not completely full.

When the storage area reaches its capacty, Telecom continues storing characters on a
“revolving” basis. For example, if the memory file is full and 1@ more characters are
wansmitted, Telecom stores these next 19 characters at the end of the memory file,
which overwrites the first 10 characters at the peginning of the memory file.

. re T3
The Memory Screen’s File Menu

elect the memory screen’s File Menu. This menu lets vou perform several tasks that

-~

rn be grouped together in 3 general categores: access the storage area (Save,
int, Erase, DP en), € rchangp a file with the other computer (Send, Rece:ve),
nd exit Telecom (Close) W vou select the memory screen’s File Menu, the

B &

w
]

scresn shows:
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Loads a Deskhiate Text file into the memorv file. Telecom displays a
list of all Deskhiate Text files you currently have stored on diskette.
From this list, select the file you want to load.

Exits Telecom. In case you have not yet saved the contents of the mem-
orv file, Telecom asks:

W

ave? 1 yes o ne

I vou do not want to save the contents of the memaoary file, select no.

To save the memory file as a Text file, select yes. Telecom prompts:
Save es:

In response to this prompt, enter 2 name suitable for a DeskMate Text
fiie
& .

Saves the contents of the memory file on diskette as a DeskMate Text
file. Telecom prompts:

Save &5

In response to this prompt, enter a name swiiable for a DeskMate Text

file. .

Erases the contents of the memory file. Telecom asks if you are sure
you want to do this by displaying:

frese memory”? v ves _ no
Select yes if vou are sure, or choose no if you change vour mind.

Prints the contents of the memory file. Telecom displays:

8

1
-
-
=
P
N
o
—
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I8!
"
T
*
m
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w

Select =11 to print the entire memory file. Select this page to print
. pra S e
only the contents of the current screen. Pressing {ALT ]2 also activates
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Serd Sends a file to the other computer. Telecom displavs
Enter extension to use:

If the file vou want to send is a DesklMate file, enter one of these

extensions:

Text file: DOoC

Index Cards file: FIL

Ledger file: WHKS
- Paint file: ~

Telecom status file: 3

Calendar file: CAL

if the file is an O5-2 fﬂe {that is, if it is not a DeskMate file), enter the
(05-9 extension to the file’s name.

After you enter the extension, Telecom displays a list of all the files
vou have stored on diskette with that extension. From this list, select
the file you want to send.

Ay
il
0
2]
.
<
]

Receives 2 file from the other computer. Telecom displays:

im

nter a name suitable for a DeskMate Text file in response to this

Telecom displavs a message when it is ready to rece ve the file:
Receiving, Press |ENIER | or enter the characters the service requires
you to use to begin the file transmission. (The keys you pre*s are not
echoed on the screen.)

To send {upioad) or receive (dowmnload) a file to or from, for example, a computer ser-
ice, prepare for your transfer on the ferminal sceen. Then, move to the memory
screen and select the send or receive options from the File Menu.

-1 recene:
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For both Send and Rece1ve, when Telecom transfers the fle, it transmits the infor-
maton directly to or from the diskette, This means that you will not see the informa-
tion being transmitted on your screen, nor will Telecom store this information in its

memory file.

The file vou transfer can be from any DeskMate application or froin a program other
than DeskMate. If, however, the file is not a text file, vou need to be sure that you

have the status screen’s word length set to § bits. (With text files, it doesn’t matter
which word length setting vou use.)

When Telecom receives g file, it saves the file as a Text flle unless you enter the exten-
{ lication. (See the list of extensions earlier in this

to work, the other computer must recognize the “startstop charac-
ters” (XOIN and XOFF). Additonally, the other computer cannot use any spedal “'pro-
tocol” for transferring the file other than what it might refer to as the “start/stop”
(XON/XOFF) protocal.

7 Displays a3 window designed to assist vou in using the memory
creen’s File Menu.
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Appendix A

Copying the DeskMate Diskette

Omne of the most Liiportant things vou can do before and while vou use DeskMate is
making & copy, or backup, of the DeskMate diskette. If you keep copies of the Desk-
Mate diskette, you'll always have current information stored in case a mishap (such as

a power failure) occurs.

Making backups involves using one of DeskMate's Main Menu functions, Disk. The
instructions in this appendix are divided into a section for kevboard users and a sec-
tion for mouse/joystick users. Read the section that pertains to your setup.

Using the Keyboard

1. At DeskMate's Main Menu, press [AL7] (7] to move the highlight to the Menu Bar,
and select the D1 s« functon.

2. You must first initlize, or prepare, a diskette to hold DesiMate. (Initalizing is
aiso called formatting.) Use the up and down artow keys to position the highlight
ontnitimlize, and press [ENTER ).

3. If vou have more than one drive, you can initialize the diskette in either Drive @ or
Drive 1. DeskMate asks which drive vou want to use for the initialization. Use the
arrow keys to highlight the disk drnive vou want to use for formatting, and press
(ERTER
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/ Copying the DeskMate Diskette

1

The screen askes you to insert a diskette in the drive vou chose. Remove the origi-
nal DeskMate diskette from the dr;ve, and replace it with a new, blank diskette (or
an old diskette you want to use again). Next, press [ENTeR .

Your diskette is formatted, and when DeskMate is finished, it lets you know by
displaying:

Replace Desk™ate disk. Fress srny key 1o continue
If you used only Drive 0 for the format. DeskMate asks vou to swap diskettes
again. Remove the new : ketre f replacing it with the
original DeskMate progra

) without swapping diskettes.

You return to the Main Menu, Your disketie is ready to hold DeskMate, so vou can
go ahead with the backup.

Press (A7) (1) to reach the Menu Bar, and once again, choose Disk.

h]

7. Use the arrow keys to position the highlight on cacrup, and

& When you formatted, you had a choice of using either Drive 8§ or Drive 1. You
have the same choice here. Use the arrow keys to nighlight your choice, and press

?\U*M

9. If you choose to use only Drive &, the screen asks you to insert the destination
diskette. This is the formatted diskette to which you want to copy. Remove the
DeskMate diskette from Drive 8, and replace it with the diskette you formatted a
moment ago.
If you are using Drive 1, your formatted diskette is already in the drive.

fier assuring that the destination diskette is in the correct drive.
152 Appendices




S it

ey

AN

g
&

s

The back }: begins. If vou're using only Drive 8, vou'l see messages asking ynu to
alternatelv insert the destinaton diskette or the cource diskette (the dibke*te fro
w the instructons on the screen.

M
- o
)
IS

up Ccm;ict:. YOu can now remove
e it with the copy vou just
a felt-tipped pen so th t you a}ways know

=

1e.
which }‘GU want to copy). Foll

11. When the bzckuﬂ is finished, vou see
the ongin Dem\ Aate diskette f'mm Dirive |
made. Be sure {o label your copy with
which diskette vou're using

12.

1

!J

3

sing the Mouse/Joystic

When vour new copy is in Drive 8, press [ENTEA |, and the Main Menu returns to

the screen.

'E
Cx

4

At DeskMate's Main Menu, point to the Disk functdon on the Menu Bar, and
click.

'x"ou mm* fw'_.—st mizm;' are, iiskette hold DeskMate. (Initizlizing is

If vou have more than one drive, vou can initialize the diskette in either Drive @ or
Drive 1. DesiMate asks which drive vou want to use for the initialization. Point to

the option for the disk drive you want to use for formatting. and dick.

4. The screen asks vou to “swap'’ diskettes. Remove the original DeskMate disxftt
from the drive, and replace it with a new, blank dzske‘:e {or an old diskeste vou
want to use agaiw}. Next, click the button
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Your diskette is tormatted, and when DeskMate 1s firoshed, it lets you know by

s

Repisce Deskfale disk., Press any key lo ccocnlinue,

you used only Drive @ for h format, DeskMate asks you to swap diskeftes
again. Remove the newly formatted diskette from Drive 0, replacng it with the

original DeskMate program ms}aette. Again, click.

If you used Drive 1 for the initalization, click without swapping diskettes.

Point to the Menu Bar's D1 =x opton, and dick.

Point to backup on the Disk Menu, and dick.

. When vou formatted, vou had a choice of using either Drive & or Drive 1. You

have the same choice here. Point to your choice, and click.

If vou c}’*cose to use only Drive 8, the screen asks you to insert the destination
diskette. This is the fo matted diskette to which vou want to copy. Remove the
Deiia.Mﬁtﬁ diskette from Drive 0, and replace it with the diskette you formatted a
moment ago.

If you are using Drive 1, your formatted diskette is already in the drive.
Click the button afier assuring that the destnadon diskette is in the correct drive,
bac;«i ip mezms If vou're using ordy Dmive 8, vou'll se¢ messages asking to to

rt the destination diskette or the sourrs diskett (the diskette from
wh;:’h vau want ia opv). Foliow the instructions on the screen.

I

When the backup is finished, you see Baciu ‘e, ch can now remove
the original Deskiiate diskette from Drive 8 a ith the copy you just
rr‘de. Be sure to label your copy with a felt-npped pen so that vou always know
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Copying the DeskMate Diskette [ A

12, When vour new copy 15 In Duove 8, dick, and the Main Menu returns to the

Important Notes about Formatting and
Backing Up

-

When you made a backup of the DeskMate diskette, you first had to initialize the
diskette so that it could hold the information Whe‘w vou rifizlize a diskette, you don't
necessarily have to use it fora b f you 2 disk drives, vou can store infor-

mation on a diskette that you use fo Tnis “data only” (Lc;}éztte need only
be initialized to prepare it for us

. rk diskettes for storing data, follow
steps 1 through 5 in the backy up Instructions.

Along the same lines, you don't nece ssgn.t) have to use the backup option for copying
only DeskMate diskettes You can use it to make a copy of a data diskette, one that

holds information but not prograr:s.
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! -5, oy d

Error Messages

f DeskMate does not seem to be working properly, first be sure that your disk system

is properly connected and tumed on. Be certain that you turned on all peripheral
es

- before turning on the computer,

Refer to the fol)ow;ng list of error “.essage, if one appears on your screen. The error
messages and their probable causes are listed in alphabetical order.

Can’t find file or disk 13 write protected

A delete function was unsuccessful because :ne file was not found or because the
disk was write protected,

Sen’t find x:DMxxxx... .

The fle for which starus was requested was not found.

ar’t il dala here

During an insert or merge in L dgﬁr the contents of the copy buffer would not fit
in the selected locanion (for example, copying a large block near the last column or

Tow).

Tanft OPEN destlinalion diskette

m

059 would not allew the Main Menu to access the destinatdon disks:
backup. The diskette must be a properly formatied Q59 diskette.




Yeirig it

ikt

PR

ateih

W

EEN

not find or could not read the selected folder. To correct, either change
he f icon Bar folder function, or replace the

Dhiring 2 backup, the Main Menu was unable to verify that the the destination

05-9 could not success!
opy operator,

[R]

Cen’t WRIT

P
I
=5

deztinat.on file

iy write data into the destination file in a Main Menu

v

o dest, distk

*
During 2 backup, the Main Menu could not write any datz to the destination disk.

The desti
programs

neration, the destination diskette was not formatted or was format-

X : ™ ) O - i 4
disyx coesz =ol contain DescMate. lopy cancelled!?

[
w
~1



in the Main Menu could not find the destination folder, or it
i atl se it

he disk is write protected.

ﬁctior error. }\ ake sure the printer Is online and prooerlv cennected. If

1 in the Icon Bar could not find the directory tha

d ice (text file), be sure that device is defined in the printer
function on the lcon Bar).
nd

1

t
op*:xons of creating the directory or canceling the echc.

(el

ing or disk g owrile prote

*ade 19 sw ar :ne e<em;wn dizectory to a2 non-existent directory,

i o

copy Ei‘:tEI}"a?‘

SR

L2

I

w

& s R

empt was made to receive

error on disk operations (save, open, ciose, merge, or execu-
his error can result from the disk being write-protected.

the Main Menu was unsuccessful because of insufficient disk

‘t receive file
a file that 1s too large to fit on the disk (Telecomy.

21
o

port

ot}

[PREN

Appendices



& sy

k1

e

b

AT

B

A

Error Messages | B
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Dimk ois full., Save deila on anoiher ooskd

o

An attempt was made to write data to a full disk. Data was not successfully writ-
ten; it is necessary to insert another disk to save the data.

Disk 18 new full

The disk is now full. Index Cards will automatically update the current record and
returm to the Index (ards main scaeen. The file must be copied to ancther

diskette.

Disk 1% write prolecied

An attempt was made to initialize a write-protected diskette.

DMAPPS was not found or wes misread. Press any key 1o exitl.

The Main Meru cannot find DMAPPS fle, which it must have to operate. To cor-
rect the ertcr, copy U ‘1 5 FPS from your master diskette or repeat the backup pro-
cedure from the master diskette to create 2 new working DeskMate diskette.

Al
DMxxxX... 130’1t in eyther program folder

After opening a selected program, the Main Menu could not find the program in
either program foider. Replace the diskette with a diskette containing the program,
then select the swap function

TREDOR - Disk 1n unknown state, use 81 0wn risk,

An initialize function was unsuccessful, usuallv becausze of a bad diskette. Some

portons of the dis kette mav be unusable. Try another diskette.

N
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B
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& " Error Messoges

-

; T S SN SR S R e o A R
3

Tercr goCurres coen:ng RSZ23Z2 driver Carn’t cocen terminal
, <
4 mooe
X -

Serial port hardware is not properly installed. The error occurred while opening

4 the R5232 driver. The program can’t open the terminal mode.
i
- T.le ex:stlE, cverwrile ;%7
3
g

This 1s 2 warning that a file is being copied to an existing file. You have the option
to cancei the copy function.

File Full

i An attempt was made to insert too many cards in one Index Cards file.
;, “.iename must be Y-8 characlers, begin witlh a-z, ard cecntain
¥ s~z cor g-%9
i lllegal characters are in vour specified filename. The filename must be 1-8 charac-
: ters, beginning with a-z, and contain a-z or 8-9.
3
: Trigeres and files are identical, is inis a single cisk copy”?

An attempt was made to copy a file to itself. This is only accepted if the source
and destination files are on different diskettes (a single disk copy).
o Toemzt not founcd., IDisx NOT inmrtiaiszed!
The Main Menu program could not find the 0OS-9 "FORMAT" program during an
. initialize function

i

J
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Error Messages / B

Format 1s: HH:MM:S5 aM cor PH

An incorrect time formai was entered.

"

grmet i=; MM/DD/YY

An incorrect date format was entered,

bt
N
5
o3
o
.
s}
-
Rl
]
<
o
(o]
b ]
~C
ol
1
3
n

An attempt was made to load an invalid Ledger, Calendar, or Index Cards file.

nsufficient disk =pace

bel/Formuls not founcg

-
[
o

The find function could not find the specified label or formula.

The search data was not found in any card.

n the disk was full.

space to exequte.




B/ Error Messages

n oug {
is not encugh room for an insert, copy, or merge operation.
hics screen doesn't fit.

-
@
vy
>3
02
an
[
[
3
@]
]
N
a
jav)
3
=

ata to a file, try emptying the copy buffer (by
selecting and copving & single character) to free more memory.

Tainmname nol found
: (1) O%-% can't find the specified pathname.
{2} The specified pathname 15 dlegal.

—
K-ZoZg Criver error

Telecom received an error from the OS5-9 serial device driver during 2 send or

receive operation.

L[4
g - M [ - -~ -~ s
Socurce Z.8x 27 BECLOPS

During a backup operation, portions of the source disk were unreadable.

This ‘clizer 2 emply
; You selected a program or data folder that contains no DeskMate files. To correct,
select another folder, or replace the diskette with one containing data and perform
: a swap operation.
Jse ot oer NI o io spezify 2 calz folder
When typing 2 filename, you entered an invalid folder number,

1gm Appendices




Error Messages | B

I ¥Z:v for goxia tftolders, or B, M4 for progream

While using the Main Menu copy function, an illegal folder number was specified.

(el u: et

Use 1.7, "2 for data tolders, or . for program folders.
Value 12 sul of range
=
A prir variable was entered that is either too big or too small.

E@ sure 1o use the proper methods to exit the DeskMate programs. If vou remove your
DesiMate disks rte at an v point other than the Main Menu, you may lose vour data. If,
far any reasor, the program exits and returns o the O5-9 prompt, turn everything off

s
T
(8}
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Appendix C

The O5-9 Operating System

4

An operating system 1s a computer program that provides basic input and output ser-
vices (such as keyboard input and video screen output) to an a'ﬂ“rmaﬁon program.
' 'stems also keep track of disk files by allowis ng you to save files by name.

DeskMate is an application program that runs on an operating svstem called O5-9

Loading DeskMate Programs from the OS5-9
Command Line :

DeskMate contains severa! programs to handle tasks such as text editing, scheduling,
and ¢ calculating. You can access these component programs individually, without using
ne DeskMate Main Menu

access DeskMate programs directly from the O5-9 command line, you must over-
ride the feature that adows DeskMate to auto-start. After en iering OQ-Q the ope ating
svetern looks for a file called “startup,” and if if exists, it is Lce:sod immediately. To

prevent f.h,és, first allow DeskMate to auto-start, and then:
1. Select clcse from the File Menu on the Menu Bar
2. At the O5-9 prompt, type:

RENAME D& CMDS/'STARTUP DESKMATE (¢

This changes the name cf the STARTUP file to DES

At this point, there are 2 wavs yvou can access DeskMate prozrams. From the 059
COmIManad Lne, vou can

1. Tvpe DESKMATE &} The DesiMate Main Menu appears.
164 Appendices
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2. Type DESK DMxxxy (where DMaxzx 1s any of the DeskMate program filenames).

This lets you directly access any DeskMate program without using the Main Menu. To

see the actual filename of a DeskMate program, use the Main Merm s status func-
tion. DeskMate programs begin with the letters “DM.”

You can follow the name of the program you want to execute with the name of a data
file, using the usual DeskMate filename standard (1: or 2: foliowed by a name of no
more than 8§ characters). If you do not spedfy 1: or 2:, the default is 1:. For example,
to access the Text Editor application with a file named “SAMPLE” from DeskMate
folder 1, vou would type DESK DMTEXT 1:SAMPLE [ENTER ).

>

The technical description of what takes p‘ ce is that the OS5-9 shell executes a process

(program; called DESK, which is the DesklMate parent process. Desk, in turn, forks to
{executes) the pmb named in the second field ’DMTEXT in the example above).
DMTEXT then loads or creates the file named SAMPL

When vyou access a program in this manner, closing the program causes the OS-9
prompt line to reappear.

{‘\ g—-« ¢ £
(35-9 Directories
f\ directory is a file kept on the disk by 059 It contains the names and begi nnmg
sk sector mumbers of other files. A directory can contain the name of arother direc-

torv. Des‘idxute uses thus multiple directory "v";CE’pY to define its folders; however,
-skMate recogrizes only DeskMate files. (If z Folder is empty message appears, the
ider does not ¢ orﬁt in DeskMate files, b might contain 059 files.)

05—9 k@ms .2 directorses acHve at one time. Cme is called the “data” directory. This
contains access to data and procedure files. The other is called the
""exemﬁs"z director rv. This directory contains access to executable files (programs).
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Appendix D

Help with Teleco

This appendix cori ust of problems you might encounter when using Telecom as
well as possible reasons and solubions. The end of the appendix contains a chart list-

s

H

ing the codes that Telecom recognize
You cannot trensmif any information to the other compnuter.

Telecom is unable to use youwr communication equipment to connect to the other com-

3

puter. This could be because of any af these reasons:

& Your communication eguipment is connected improperly. Follow the instructions

in the owner's manual for your equipment for connectin ting it, and try the connec-
tion again

& You set your modem improperly, or you are using the wrong sequernce for making
2 modem connection. Follow the instructions in your modem rmanual, and try the
connection again.

e

@ You are not at Telecom’s Terminal screen. Move to the Terminal screen, and &y the

connechon ag:.m

5

& The other computer is not set up properly for cormmunicating. Have the other
computer set up properly, and Ty the connection again.

You recetve many strange characters from the other computer.
Telecom and the other computer are probably using different baud rate, word length,

arity, or stop bit setungs. Move to the Status screen, change Telecom's settings to
match those of the other computer, and return to the Terminal screen

“t:‘

receive occasional strange characters from the other computer.

m




i
4
3

1 1 3 5

You are probably receiving nonstandard characters from the other ¢ p ter that Tele-
niz ut

com does not recognize. Fin if vou can have the other cozrpa d usted so that
it will no i onger sen d You tbese nonstandard characters. {The characters that Telecom
recognizes are listed at the end of this appendix.)

The transmission befween you and another computer “'hangs up.”
Either Telecom, 08-9, or the other computer transmitied a [C1R 3 and, by doing so,

stopped transmission. To resume transmission, press vuTHL‘ 0 | If pressing (CifrL @
onnecticn again.

I

does not work, disconnect from the other computer, and Ty t‘n

m
)

if you encounter this problem repeatedly, it might be because vou are exiting the ter-
minal screen (for purposes other than file transfer) while letting the other computer

continue to tranemit information to vou. This causes O5-9 to autornatically attempt to
stop transmussion by sending a [CTRL | § ) character to the other computer.

The lines you receive are displaying on top of each other.

Tel LEcom and the other computer are handling the carriage return ((ENTER)) character in
fferent wavs. Move to the status screen, set Telecom’s Line Feed to ON, and return
to the terminal screen.

i

The lines you receite are double spacing.

com ard the other computer are handling the carriage return ((ENTER ) character in
. Move to the status screen, set Telecom's Line Feed to OFT, and retum
the temjr.ai screen.

The characters you type are displaving in duplicate.

Both Telecom and the other computer are causing your computer to “echo” (display)
the characters you type. Move to the status screen, set Telecom’s Echo to OFF, and
return to the terminal screen,

The characters you type are not dispiaving,

!

’

gcom nor the other computer is causing your computer to “echd’ fﬁﬁp‘ 3
rs you type. Move to the status screen, se Te1e-:om's Echo to ON, and
return to the terminal screen.

{l -/
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3

- You cannot transfer files to ov from the other cormputer.

i o : . .

F Telecom and the other computer are probably using ditferent file transfer metheds; for -
the transfer to work, both computers must use the same method.

The only method Telecom can use is the startstop method. | LUsing this method, Tele-
i s other than [CTRL] (8], for stop trans-

com transfers the fi
I ey -

referred to as “XOFF"), and [CTRL [0, for start transmission {also

4 TXONTY.
§ Codes recognizea by Telecom appear in the following chart,
Printed Keybosrd Prirted KevDosrsd
Decimet hex  Binsry Cherscier Charssiat Decimal Hax  Binary Cherscier Cheracter
% 0 00 OUKDOO0 21 35 00010104 (Cecu
{ 1 o1 0000000 EECA 22 18 00010110 {CTRLIV
2 02 00000010 T 23 1T pon1oie CTRL )
;ﬁ 3 03 000DD0TI [faLC 26 18 00011000 (AL
¥ 4 D4 DOOOOTOT CRLID 25 18 00011001 CirL ]
5 08 0000010t (TRO)E 26 1A 00011010 Sy
5 6 06 00000110 CIRLIF 27 4T oo0tion
? 7 07 0000011 2 1C 00011100
8 06 0OX0C bacespess 22 1D 000311101
& 0% OO0t b 30 1E 00011190
3 10 DA OOO0I010 hne foed 3 P 0001111Y
3 tr 0B 0oe0ont 32 20 DUIB0G00 [SPrCEBRA Y
12 6C 03001100 torm fesc 3 21 0100001
ke i3 Co OODOIICY emmape retum 34 22 00100010
14 DB DXONIC 35 23 00100013 # #
* SO SRR 3 2¢ 00100100 5 H
15 10 00010000 37 25 00100503 % %
17 11 00LI000T XON 38 25 00100116 & &
5 18 12 oCoit0ie 39 27 00100t
1g 15 COCI001T XOFF & 26 00101000 ( (
3 20 T4 DO0ICOC £1 23 005000 ) 3
i
3
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Glossary
: SRR
echo. 4 setting in Telecom that lets vou adjust the way Telecom is displaving the char-
cters vou tvpe. It tells Telecom whether to echo \cns;na\,\ or not echo {*‘10»‘ Hsplay)
: vour characters. i
field. A defined screen or file area that is used to store a unit of infoermaton.
4
# co1a e ¢
field label. Indicates the beginning and end of a set of data.
i filename. A set of characters used to identifv a file.
folder. A directory on the diskette that contains DeskMate program and/or data files.
format. Preparing a disketite to hold DeskMate programs or data. (Also called
irutializing.
1 highlight. A portion of the screen shown as reverse video or outline that marks an
app‘ncaticn or cption for selection.
3 host computer. The operating computer that transmits the host program to terminals.
host program. A program that lets a computer make its resources available to
7 terninals.
45 . A - { : v sl e = ¥ - 1: r . . n
icon. A figure {drawing) that represents a DeskMate application or funchion.
‘ initialize. Preparing a diskette to held DeskMate programs or data. (Also called
$ formatting.)

insert mode. A function that lets you insert characters that you type into the text,
rather than type over them.

kev field. The priority field when performing a sort funcfion.

= lire feed. A setting in the Telecom application that lets you adjust line spacing. It tells
Telecom whether to add an extrz line to each ._zu*nag? return character that it
receives from the other computer

frater

ions with the host program (via Telecom).

£

log off. To ceass communicat
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log on. To begin commurucating with the host program (via Telecom).

merge. A function in DeskMate that inserts a document or a piece of 2 document from
the curent disk into the document on the screen.

modem. A device that enzbles computers to communicate over telephone lines.

network. Communications channels designed for use with the Telecom application.

operating system. A group of programs that manages the flow of information in the

computer.

overflow. A condition that occurs when the result of an operation exceeds the capacity

of storage.

overstrike mode. A function that lets vou type over a character, changing the former
character to the one you typed.

parity. An error detection method.

pathname. Gives directions to DeskMate and O5-9 on how to find an existing direc-
tory or where to put a new one on the disk.

pixel. Short for picture element. A pixel is the smallest division of the video screen
that can be turnied on or off or set to a color.

point. Moving the mouse or joystick untl the tip of the pointer rests over the dasired
object.

pointer. A small arrow on the screen that can be moved with a mousefjoystick to
select (highlight) options on the screen.

relational operator. A svmbcl tha! designates a comparison between two pieces of
information. For example, > (greater than) is a relational operator.

select. Choosing a function or appiication in DeskMate by highlighting (or pointing)
2nd then pressing the button on the mouse/joystick or (ENTER | on the keyboard.

Glossary
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Glossary

serizl port. A hardware ¢
modem, etc.) is transmitisd and recen ;?

gpreadsheel. A screen layout for the Ledger application that contains 99 columns and
9 rows in which you can enter data,

stop bit. A setting that separates elements of information during transmission.

aiﬁng A s:*o;p of characters in a sequence that is used in DeskMate to search for

terminal. A keyboard monitor or a campuier from which an operator can comumuri-
cate with another computer via a program (such as Telecom).

utility. A program in DeskMate that performs a frequently needed task, such as copy-
mng, pr;nmig, esc.

XOFF. The characters used to stop transmission in Telecom.

XON, The characters used to begin ransmission in Telecor.

s
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H 8 18, 28, 107, 138, 149
nelp
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for Biock Menu 93, 138
for Card Menu 1%, 109
for Cell Menu 132

for Date Menu &9
for Disk Menu 19
for Edit Menu 118

FS 3
for Fie Menus 17, 87, 93, 99, 106, 113, 124,

141
for Find Menu 96, 108
for Foider Menu 18
for Format Menu 163
for Insert Menu 182
for Text Menu 89

@9

ABS 129, 130
aad 194
ALT kevs 8,173
appendices §, 181-75
applbications
files 12
returting to 28
arTow kevs 7, 8% 1
See alse scrolling arrows
axveragir‘g totals on a spreadsheet

AN ERsTe

AVG 72,129

budgets, setting u

[£2°]

e
r?ﬂ
o
ol

Ca 25
chuate 131

Cai»ncaz‘ Pr
Date M nu 8%
entering 3557
exiting 39
File Menu 86-87
finding entries 3839
HGlp Window 9@
insgructons 83-84
kevboard techniques 84-83
Menu Bar 84

niouse/ioystick techniques 85
printing from 38
Text Menu 87-89

CAL extension 148

cancel option 22

Card Menu 48-51, 995-100, 105, 1058109

carriage width 23

CE 25

Ceils Menu 71, 72, 131-32

cells, spreadsheet 65, 68, 121, 125-32

cha.nge 96

characters

v color 2627
control 144 .
display 76, 141
e’ib }Q"}
number on one line 24
ecogrized by Telecom 145, 169-71
revolving storage of 146
suing of 93, 106, 131
CHX command 166
drcles, cuawm; 57-59
carsle tool 115

e 5 "7
r1gg, 1i7 .

...4
4
i
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63, 86,93, 112, 112, 2
27,113, 119
1 least RS 19
columns, spreadsheet 65, 121
widdh 121, 122
181
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COMM program 133
communications See Telecom apphcation
communications board 74
commuter services 78, 77, 144
connecting ecuipment for Telecom 2
connecting to Qmer computer 143
control characters 144
copy 15, 87, 93, 127
copv and paste selected areas 116
copving

diskettes 12, 151-55

files 15

corrol optien uthty 27

in insert mode 36

using keyboard to move &19

using mouse/jovstick 1¢ move 10-11
cursor control devices See Kevicard; Mouse!

ffvcﬁck
¢ paste selected area 116

’}

daisy whee!l printer 2
data area, lndex Card Format Screen 101-182
data directory 165
data disketie 12
data files 14
date folder 18
data, searching for
Caiendar 38-39
Index Cards 53-54

loading from O5-9 command line, 16465

manual i-4

reference i, 81-149

sample sessions i, 26-79

swapping diskettes 19
de-:tinau’on diskette 152, 154
device 7-11, 56, 119
directories, OQ 165-66
directory of folders, 22
DHQCfO?) window 13
Disk Extended BASIC 5,
diskettes

o
~3
=N

See also detz diskettes
uia,,.av utility 26-27
DMC extension 148
DOC extension 148
cone opdon 22
oubie chick 1@, 11
Dow Jones Retrieval Service 144
dowrnload files 148
drag 10
drawing 53-59

Echo 76, 141, 168
edit 88
calendar utility 34
Poi ier utility screen 22
Index Card apphicaucn data 51
text 40-45
edit characters 182
Edit Menu 117-19
e‘ﬁ" 1 367
eQ¢pm°n‘ requiremerus -2, 74, 133-35
Erase files 147

Date Me Caiendar 8S eraser tool 114
delete 16~ 1-52, 87,95, 10, 108, 128 erase selected area 116
Ses also c: lete feid error messages 156-63
delete feid 163 execution directory 165
Deskviate exit 183, 184, 1¢5, 108
appendices {, 151-75 exizng
copying diskerte 151-58 Calculator utility 28, 23
equipment requirements, 1-2, 74, 133-35 Calendar 39
getnng started i, 3 28 Dieskimate 14
%
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field labels 106

fieids 100
Ses alse delets field

file
extensions 148
names 15, 16
opering 14, 86, 93, 112, 123, 141, 147
program 14, 1%, 17
receiving 146
saving 86, 94, 112, 123~
sending 148

status 17

Files Menu
Calendar 86-87
index Card 98-99, 105166
Ledger 123-24
Main Meny 14-17
Paint 11 -1"3
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older Menu 18

Folder utibty 23-22

Eormat Menu 182-164

formas ~~M.4ﬁ~45 o9, 1&’@ 02,
41 H

cting vﬂth mcuse/jcysﬁck 11

geting started in DeskMate i, 3-28
greater 187

hand-held caloulator See Calculator
Help Windows 8, 17, 19, 28, 92, 96, 184, 105,
119, 132, 145
See aiso 7 help
Host program 133

icon 6
lcon Bar 7, 8, 24, 28, 9¢, G5, 119, 132
functions 2€~
Index Card app:;sation 1, 46-54, 97-189
Format Screen 100-104
Insert Screen 184105
Main Sﬂ'eer S8-108
Menu Bar 97
View Soeen 183103
information services, on-line 75, 77
unnuljm_mg c‘usxettes 19, 151-55

ot mode EC 36
i option 49, 184
1 Screen 104-105
INT 129, 136
Invahd formula 128

Y

Kevboard
to access Menu Bar 14
d cai”u“atgv ut

and

eul.xg text with 4244
to formas, copy diskettes, 51-53
znc He Ip windows 28

and Ledger 122 125

moving around screens with 8-1¢
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Palette menu 58, 61, 113 resolution 11€, 115

paper, prir inter 24 Telecom 135-36

Yfart} 76, 148 - scrolling

Y&. 75,77, 13 arrows 13, 28, 94 96, 199, 132

[Se3d eaashects 6667

L‘"Lna“ 23‘ oz searching for daa 3839, 53-54
pa*ts”xs 55-59, 113, 11819 se Ee':f 94, 125
penal tool 55, 56, 114 select toot 116
FIC extension 143 Scnd files 148
pixei 118 Serial Port 140
point 18 shadow functons 48
pointer 19 SHIFT 9-19
press 18 click 19, 11
print 18, 86, S, 99, 109, 112, 124 solid paste selected areas 117
Printer lines per p;ee 3 sort dats 18
Printer line width 23 sorting data folder files 18
Printer baud rate 22 sort crder 163
Printer carriage width 24 source ciskettes 153, 154
Printer device 24 spray tool 115
Printer paper 24 spreadsheets 64-73, 126-32
pninters, daisy wheel 2 averaging expenses 71-72
printer utility 22-24 caiculating totals, 76-71, 131
printing entering amounts 67
from Calendar 38 exiting 72-73
from Folder Menu 18 instructions 126-22
from Ledger 72 labeling 64-67
from Telecom 147 printing 72, 124
from Text Editor 45 writing formulas, 67-68, 128-30
Lee nlso primt status of files 17
Pregram fies 14, 15, 17 Status Screens, Telecom 75, 135-36, 138-42
program folder 18 File Menu 141-42

stop bit 76, 148
Receive Gles 148 string of characters 95, 186, 131

reference i, 81-149 SUM 129, 130

relational 'wpeu_t"rs 106 swap 19, 166
renaming datz files 17
Tev o.vm;: sto ;age of characters 146 Tandy DC-Modem I 134
rows, spreadsheet 65, 121 andy Model 4 133
R5I32 ¢ .Mbi 13 *and; 100 13
R&-232 Pak 134, 135, 148 Tandy 200 133
Tandv IW" D: kMate 133 .
Telece ; 3, 13349
Ch:.’at‘ ers recognized by 144, 145, 169.71

mouving around on




going offiine 78
mstructions 137
Menu Bar 136
printer settings 144
screens 13536, 13849
sethng vp 74-76
trouble shootng 16769
viewing transmussions 78-79
View Menu 138
termanal program 133
Terminal screens, Telecom 76, 135-36, 14245
User Menu: 145
text
editing Ser Text Editor application
pninting 45
tool 116
tvping 9-18, 4642
Text Editor application 1, 48-43, 91-96 ‘
Block Menu 94-95
File Menu 93-34
Find Menu 95-96
instructions 91-92
Menu Bar 92
Text Menu, Calendar 87-89
Time utility 25-26, 34
Tool Menu, 57, 11417
Top margin 23
Total lines per page 23

J S

£,

transrnissions, viewing 7579
transparent paste selected areas 117
ITY 144

tutorials 29-79

typing text 9-18

undo &8, 117

upload files 148
upperfiowercase switch 9, 18
user ID 75, 77, 139

User Key 8 13948, 145

User Key 9 135-48, 145

User Menu 145

utilifes 20-27

Videotex program 133
View Menu 76, 78, 138
view ophion 53, 99, 165
View Screen 1053.109

WKS extension 148
Word size 76, 140
writing a letler 4045

XOFF character 144, 169
XON character 144, 168
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